MAC-graphics
A designer's visual guide to graphics for the Apple Macintosh...

2nd Edition
MAC-graphics®

A designer's visual guide to graphics for the Apple Macintosh...
<table>
<thead>
<tr>
<th>Type and image</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE AND HALFTONE IMAGE</td>
<td></td>
</tr>
<tr>
<td>Type on halftone image</td>
<td>50</td>
</tr>
<tr>
<td>Tint type on halftone image</td>
<td>52</td>
</tr>
<tr>
<td>TYPE AND LINE IMAGE</td>
<td></td>
</tr>
<tr>
<td>Type on line image</td>
<td>54</td>
</tr>
<tr>
<td>Tint type on line image</td>
<td>56</td>
</tr>
<tr>
<td>IMAGE IN TYPE</td>
<td></td>
</tr>
<tr>
<td>Halftone image in type</td>
<td>58</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rules and shapes</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>RULE LEGIBILITY ON TINTS</td>
<td></td>
</tr>
<tr>
<td>Rule thickness on positive/negative background</td>
<td>64</td>
</tr>
<tr>
<td>Frames on positive/negative background</td>
<td>66</td>
</tr>
<tr>
<td>Black rule on tint background</td>
<td>68</td>
</tr>
<tr>
<td>White rule on tint background</td>
<td>70</td>
</tr>
<tr>
<td>Tint rule on positive/negative background</td>
<td>72</td>
</tr>
<tr>
<td>Rule pattern on tint background</td>
<td>74</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type and tints</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE LEGIBILITY ON TINTS</td>
<td></td>
</tr>
<tr>
<td>Positive type on different tints</td>
<td>38</td>
</tr>
<tr>
<td>Negative type on different tints</td>
<td>40</td>
</tr>
<tr>
<td>Type on different line screens</td>
<td>42</td>
</tr>
<tr>
<td>Tint type on positive/negative background</td>
<td>44</td>
</tr>
<tr>
<td>Tint type on tint background</td>
<td>46</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Typography</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE BASICS</td>
<td></td>
</tr>
<tr>
<td>Typefaces</td>
<td>14</td>
</tr>
<tr>
<td>Type color</td>
<td>18</td>
</tr>
<tr>
<td>Type size</td>
<td>22</td>
</tr>
<tr>
<td>USING TYPE</td>
<td></td>
</tr>
<tr>
<td>Leading</td>
<td>24</td>
</tr>
<tr>
<td>Word and letter spacing</td>
<td>26</td>
</tr>
<tr>
<td>Page set-up</td>
<td>28</td>
</tr>
<tr>
<td>Type distortion</td>
<td>30</td>
</tr>
<tr>
<td>Special effects</td>
<td>32</td>
</tr>
</tbody>
</table>
### Line screen

**LINE SCREEN BASICS**
- Different line screens magnified (10x) 78
- Tint value on different line screens 80

**GRADUATION ON DIFFERENT LINE SCREENS**
- Graduation on different line screens 82
- Defining graduation tint 84

### Halftone image

**HALFTONE IMAGE**
- Line screen and halftone image 108
- Line conversion from halftone 110
- Halftone patterns 112
- Duotone and tri-tone posterization 114
- Duotone and tri-tone grayscale 116
- Duotone and tri-tone grayscale re-mapping 118
- Ghosting halftone 120

### Line art

**DESKTOP PATTERN CHART**
- Desktop pattern on positive/negative 88
- PostScript fill 90

**WORKING WITH LINE ILLUSTRATIONS**
- Line art scaling 92
- Line art skewing 94
- Transparent holes in images 95
- Line art blending 96
- Tiled fill line art 100
- Line art and tint line art 102
- Line art on tint background 104

### Process color

**PROCESS COLOR**
- Process color and line screen 124
- Process color scale 126
- Color in graduation 220
- Color on white, gray and black 234
MATCHING COLORS
Monochromatic color match 250
Blending color match 252
Contrast color match 254
Complementary color match 256
Color and gray match 258
Four-color mix and match 260

PROCESS COLOR AND TYPE
Color type on screen background 262
Color type on graduated background 264

GRAPHIC SAMPLES
Process color and line art 266

IMAGE RE-TOUCHING
Image modification using filters 270
Color correction and modification 272
Image enhancement 274
Image compositing 276
Painting black and white 278

MAC-graphics dictionary 282
Tips and tricks 287
Gallery of works 291
Bibliography 295
Publications 296
"graphic art has entered a new age of accessibility..."
INTRODUCTION

What is MAC-graphics®? It is graphics generated by the Macintosh. The type, tints, images, rules and colors. This publication is a companion to the MAC users (DTPers, those who need to manage graphics effectively and those who require commercially printed results) in the pre-press industry. It addresses their problems of visualising the final results in print and not merely on screen.

This manual was put together with three MACs — one Macintosh IIfx, Apple 8•24 video card, 13" AppleColor RGB monitor and 8 MB RAM; one Macintosh IIfx, SuperMac Spectrum/24 Series III video card, SuperMac 19" Trinitron color monitor and 8 MB RAM; and one Macintosh IIfx, SuperMac Spectrum PDQ 24 bit video card, SuperMac 19" Trinitron color monitor and 32 MB RAM. Other hardware used included a Microtek MSF 300Z color/grayscale scanner, Scitex Iris Smart Scanner, Canon 500 Color Laser Copier, QMS ColorScript 100 Model 30, Apple LaserWriter II NTX, Scitex Dolev PS PostScript Imagesetter, Scitex PS Bridge, Linotronic L630 PostScript Imagesetter, and Agfa Compugraphic SelectSet 5000 PostScript Imagesetter. For software, Aldus PageMaker 4.2, FreeHand 3.1, Illustrator 3.1, QuarkXPress 3.0, Photoshop 2.0, Adobe Type Library and Adobe Type Manager were used extensively. Printing was done on a six-color 28 x 40 inches Speedmaster press using Toyo ink.

Drawing on our vast experience in graphic design over the past 8 years with Octogram Design and the authors’ 28-year experience as book designer, art director, teacher and print manager, it took us two months with 9 staff to revise (design, write, set text and graphics, and color separate) this manual. Feedback from users of our first edition enabled us to make adjustments to their needs, with
some areas simplified and others enlarged. 🟡 Our intention was to make this manual useful for MAC users who need accurate — especially so in color management — and proven results to avoid costly last-minute complications in the publication process. For creating those pages with graphics, we used Aldus FreeHand extensively. In this edition we incorporated Photoshop which we found to be very versatile in image re-touching. We chose FreeHand because it works well with PageMaker. We also used Adobe Illustrator as it is very compatible with Photoshop. 🟡 In the manual, technical language is reduced to a minimum and we often go down to the basics as we are aware that there are many newcomers to the world of DTP. The manual provides a shortcut to visualisation. It assists MAC users to make fast and accurate graphic decisions. Teaching points are highlighted in second color. 🟡 The revised and improved manual is divided into four parts. The first part refers to type, screen, images and rules — their wide-ranging applications and possibilities and how they can be achieved. In the second part, references are made to process color in relation to its usage in the first part. A diskette is included to assist MAC users to manually calibrate their color monitors. Illustrated examples show MAC users the processes and results, with short technical notes explaining how they were achieved with popular software. We also incorporated a chapter on image re-touching which is really fun. 🟡 Finally, there is the illustrated MAC-graphics® Dictionary, a collection of terms commonly used in the industry. Also a new section is devoted to tips on how to achieve common useful graphics. 🟡

Acknowledgements This 2nd edition is made possible by people who believe in the power of DTP and have committed lots of time and money in their pursuit of excellence. Our thanks to them for their assistance: Pica Colour Separation Pte Ltd, Craft Print Pte Ltd, Voltra (S) Pte Ltd, Typeset Gallery Sdn Bhd, Superskill Graphics Pte Ltd, Koford Prints Pte Ltd and Paragraphics Sdn Bhd.
The first edition of MAC-Graphics® was published in 1990. Since then skeptics of desktop publishing have finally been convinced of its latent design and production power. It has changed the nature of the publishing world. Color images stored in digital files can be transmitted, mutated, decolorised, proofed and finally output in films ready for press. Professionals in the business of communication are pressurised to master this new tool.

The advent of sophisticated digital color proofing systems, like the 3-M's Digital Matchprint, have also changed the way we work. You can create color proofs much faster and more efficiently than the traditional press or chromalin proofs. You get immediate results and you can also link directly to electronic prepress systems with minimum fuss. You save time and cost. With the printing industry moving towards digital printing presses, the link between the Macintosh may even be shorter in the very near future. As it is, the gap between design and production is already narrowing. However, a lot of people who have gone into desktop publishing are often unfamiliar with the basic production and printing process. This manual seeks to bridge that gap, helping MAC users to make right production decisions, whether in the choice of color or tint, word or letter spacing, line or halftone images. It also explains clearly how to achieve the final result step-by-step, without unnecessary time wastage on your MAC.

For commercial color printing, the monitor screen is still an unreliable visual color guide. It is safer to color check with a reliable color printer such as the Canon Color Laser printer or Tektronic, or better still proof your films through an off-press (3-M, Dupont, Kodak) or an on-press color proofing system in the traditional color separation house.
Since our first adventure with this manual in 1990, the new generation of graphics software has improved tremendously both in ease of use and production quality. As we have grown to be totally dependent on our faithful MACs and our wide array of sophisticated hardware, our standard of color visual presentation to our clients is unsurpassed and our production time frame very much shortened. Our cost is down while our staff morale is up. The DTP industry is still full of excitement and challenge. I hope this 2nd edition will fully familiarise you with the basics of the design and production process and encourage you to explore further the unending possibilities of desktop publishing.

Lim Ching San
October 1992
Spacing between words and letters is usually fixed by default at an acceptable standard set by the software.

- Spacing is affected by the width of the text block (line width or measure). A narrow width will give you unsightly spacing with white gaps in between. A bigger width will give you more even texture. As a general guide, if word spacing is tightened, letter spacing should also be tightened. It word spacing is loosened, letter spacing should also be loosened.

96 pt

Anatomy of type
Typographic design is the art of using type effectively. It performs the task of communication with maximum clarity and visual satisfaction. There are thousands of typefaces available from leading type houses. Communicating with type depends on an acute understanding of the basic visual elements — space, line, column, lead, size, color, etc. All working together to make the printed page readable and pleasing. Typography is visual engineering. We can classify typefaces into four main groups: Serif, Slab Serif, Sans Serif and Decorative.
Serif Typefaces

Characteristics:
- Thicks and thins
- No great contrast between thicks and thins.
- Serifs
- Scooped serifs being heavy.
- Stress
- Oblique vertical stress.

History:
Designed by Francisco Griffo for the Venetian printer Aldus Manutius in 1495. A very popular 'Old Style' typeface widely used in many types of design, especially popular for books.

Bembo

Other Serif Typefaces
- Baskerville
- Bodoni
- Cheltenham
- Concorde
- Garamond
- Goudy
- Life
- Palatino
- Plantin
- Times
- Walbaum
- Weiss
History:
Helvetica was designed in 1957 by Max Miedinger. It is a very popular typeface, highly readable and well-balanced.

Sans Serif Typefaces

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890

Helvetica

Other Sans Serif Typefaces

Avant garde Eurostile Folio Franklin Gothic Futura Helvetica Kabel News Gothic Univers

Characteristics:
Thicks and thins
Evenness in the strokes.
Serifs
No serifs.
Stress
No noticeable stress.
Slab Serif Typefaces

Characteristics:
- Thicks and thins
- Lack of contrast in thicks and thins.
- Serifs
- Strong, bracketed slab serifs.
- Stress
- Lack of emphasis in vertical stress.

ABCDEF

Glypha

Berthold City™

Memphis Serifa

History:
Lubalin Graph was developed by Tony Di Spigna using Herb Lubalin's original type, Avante Garde. Its legible design makes it suitable for use in a variety of sizes, for a variety of design disciplines.
Typography

Decorative Typefaces

History:
This decorative typeface was designed in 1936 by M.R. Kaufmann. A very popular typeface widely used in various display forms.

Characteristics:
These typefaces resemble hand-writing and are varied and individual. They range from traditional to contemporary, from delicate to rugged.

Other Decorative Typefaces

Arnold Bocklin
Brush Script

Dom Casual
Freestyle Script

ITC Zapt Chancery
Park Avenue
Parrots in their Native Lands

Parrots come from South America, Australia, Asia and Africa. South America has the most parrots and Africa has the fewest. Most live in forested areas but some live near mountains or deserts. Many are brightly colored, some are black. Usually they are colored so that they cannot be seen easily. We love them as pets but in their homelands they are pests that destroy crops.

There are altogether 315 species of parrots. The smallest is the Pygmy Parrot (10 cm) and the largest is the Hyacinth Macaw (1 m).

In the wild parrots like to do things together, so they travel in pairs or groups. Even in a large group they will choose the partner they want to stay with all their lives. Because they are so choosy about their partners, many parrots are hard to breed in captivity. They nest in hollows in hillsides and trees. This makes the Monk Parakeet very unusual because it builds a nest out of twigs.

Flamingos

Flamingos are quite amazing creatures with their long necks and skinny legs that look as if they may give way any time. Despite their curious appearance, the flamingos are one of the oldest species of birds existing today. Cave paintings done about 7,000 years ago are found in southern Spain and the name "Phoenix Birds" had been given to the flamingos since ancient times.

Scientists have found fossils of flamingos in Europe, North America and Australia. From them we know that flamingos could be found in large numbers all over the world and not just at the areas where they are found in these present days.

In ancient times the flamingos were killed for their skin and meat because people believed they would live forever if they owned a flamingo skin. The Romans regarded the pickled tongue of the flamingo a delicacy to be served at feasts given by the Roman emperors.

Flamingos in the wild live in huge flocks. The males are larger than the females but apart from the size, it is very difficult to tell the males from the females because they look alike.

They like to live in shallow lakes and salt lagoons which have very little plants growing in them. These places are often surrounded by hot desert-like country. Flamingos are now found in the tropics and sometimes in high and lonely places.

Typefaces are like people. They come in all shapes, sizes and colors. Each with its own personality. In publication designs, it is often better to limit yourself to using one or few families of typefaces.
Helvetica Light 9/11 Type has 'color'. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.

Helvetica 9/11 Type has 'color'. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.

Helvetica Bold 9/11 Type has 'color'. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.
New Century School Book 9/11 © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.

Galliard 9/11 © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.

New Baskerville 9/11 © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.

Garamond 9/11 © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.

Palatino 9/11 © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message. © Type has ‘color’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.

Different type (Serif), same leading.
Gill Sans 9/11  "Type has ‘color’’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.  "Type has ‘color’’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.  "Type has ‘color’’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.  "Type has ‘color’’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page. Such tonal quality can also set the mood or tone for the nature of the message.  "Type has ‘color’’. The color refers to the general tonal quality when viewed as a body of type. The color is the range of gray. It could be extra fine (when using Helvetica Light) to densely dark (Helvetica Black). Each type has its own weight. The selection of type, size, leading, word or type spacing (kerning) affects the overall color. Using the standard kerning and word-space with types, we illustrate here the color of type. Color of type can provide interesting contrast or harmony for publications like magazines or newsletters which normally have a mixture of topics within a single page.
Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing.

Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing.
Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing. Most DTP software today can generate types from 3 points to 3000 points. Together with Adobe Type Manager and the selected fonts downloaded, fonts can be very smooth on screen. You can therefore make accurate adjustment of type, space, kerning on screen before printing. Depending on your printing device, small types may lose their fine serif during printing.
MAC-graphics

(Serif) Garamond, 9 on 9 points  Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points. If you select a 20 points type, your auto leading will be set at 24 points.

(Serif) Garamond, 9 on 11 points  Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points. If you select a 20 points type, your auto leading will be set at 24 points.

(Serif) Garamond, 9 on 13 points  Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points.

(Serif) Garamond, 9 on 15 points  Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points.

You can measure the leading from baseline to baseline. Some software like QuarkXPress allow you to select type and raise or lower its baseline independently. Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points. If you select a 20 points type, your auto leading will be set at 24 points. You can measure the leading from baseline to baseline. Some software like QuarkXPress allow you to select type and raise or lower its baseline independently. Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points. If you select a 20 points type, your auto leading will be set at 24 points. You can measure the leading from baseline to baseline. Some software like QuarkXPress allow you to select type and raise or lower its baseline independently. Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e.

Technical Note: QuarkXPress 3.0 • open a Text Box • select Character Tool and type your text in the Text Box • highlight the text • go to Style Menu and specify your leading in points
Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points.

If you select a 20 points type, your auto leading will be set at 12 points. If you select a 20 points type, your auto leading will be set at 24 points. You can measure the leading from baseline to baseline. Some software like QuarkXPress allow you to select type and raise or lower its baseline independently.

Some software like QuarkXPress allow you to select type and raise or lower its baseline independently. Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points. If you select a 20 points type, your auto leading will be set at 24 points. You can measure the leading from baseline to baseline. Some software like QuarkXPress allow you to select type and raise or lower its baseline independently.

Leading refers to the measurement of space between the line of type. Most DTPers find it convenient to use the default setting at Automatic for leading. Automatic leading in your MAC gives a 120% space between baselines on the choice of the original type size, i.e. if you select a 10 points type, the MAC will auto-set your leading to 12 points. If you select a 20 points type, your auto leading will be set at 12 points. You can measure the leading from baseline to baseline. Some software like QuarkXPress allow you to select type and raise or lower its baseline independently.
### Word Spacing and Letter Spacing

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Minimum</th>
<th>Desired</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word spacing</td>
<td>80%</td>
<td>100%</td>
<td>200%</td>
</tr>
<tr>
<td>Letter spacing</td>
<td>-5%</td>
<td>0%</td>
<td>25%</td>
</tr>
</tbody>
</table>

Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers. Spacing is affected by the width of the text block (line width or measure). A narrow width will give you unsightly spacing with white gaps in between. A bigger width will give you a more even texture. As a general guide, if word spacing is tightened, letter spacing should also be tightened. If word spacing is loosened, letter spacing should also be loosened. ❌ Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers.

### Technical Note: PageMaker 4.2

- Helvetica 9/12 points, no auto hyphenation.
- Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers. Spacing is affected by the width of the text block (line width or measure). A narrow width will give you unsightly spacing with white gaps in between. A bigger width will give you a more even texture. As a general guide, if word spacing is tightened, letter spacing should also be tightened. If word spacing is loosened, letter spacing should also be loosened. ❌ Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers.

### Minimum - Maximum

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Minimum</th>
<th>Desired</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word spacing</td>
<td>5%</td>
<td>5%</td>
<td>100%</td>
</tr>
<tr>
<td>Letter spacing</td>
<td>-10%</td>
<td>-2%</td>
<td>5%</td>
</tr>
</tbody>
</table>

Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers. Spacing is affected by the width of the text block (line width or measure). A narrow width will give you unsightly spacing with white gaps in between. A bigger width will give you a more even texture. As a general guide, if word spacing is tightened, letter spacing should also be tightened. If word spacing is loosened, letter spacing should also be loosened. ❌ Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers.

### Minimum - Maximum

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Minimum</th>
<th>Desired</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word spacing</td>
<td>120%</td>
<td>150%</td>
<td>200%</td>
</tr>
<tr>
<td>Letter spacing</td>
<td>5%</td>
<td>25%</td>
<td>80%</td>
</tr>
</tbody>
</table>

Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers. Spacing is affected by the width of the text block (line width or measure). A narrow width will give you unsightly spacing with white gaps in between. A bigger width will give you a more even texture. As a general guide, if word spacing is tightened, letter spacing should also be tightened. If word spacing is loosened, letter spacing should also be loosened. ❌ Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers.

### Minimum - Maximum

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Minimum</th>
<th>Desired</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word spacing</td>
<td>150%</td>
<td>180%</td>
<td>220%</td>
</tr>
<tr>
<td>Letter spacing</td>
<td>10%</td>
<td>50%</td>
<td>100%</td>
</tr>
</tbody>
</table>

Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers. Spacing is affected by the width of the text block (line width or measure). A narrow width will give you unsightly spacing with white gaps in between. A bigger width will give you a more even texture. As a general guide, if word spacing is tightened, letter spacing should also be tightened. If word spacing is loosened, letter spacing should also be loosened. ❌ Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers.
Spacing between words and letters is usually fixed by default at an acceptable standard set by the software manufacturers. Spacing is affected by the width of the text block (line width or measure). A narrow width will give you unsightly spacing with white gaps in between. A bigger width will give you a more even texture. As a general guide, if word spacing is tightened, letter spacing should also be tightened. If word spacing is loosened, letter spacing should also be loosened. 

Technical Note: QuarkXPress 3.0 • Helvetica 9/12 points, no auto hyphenation
The following four pages show how each page is structured using the four key elements: the title, column, pulled quote, space and folio. The column is a 'pillar' of continuous body type. Most publications have two to five columns. Ideally, each column width should have between 5 and 10 words (about 60 to 80 characters). Leading between lines gets wider as the number of words per line increases to make reading fast and comfortable. Short lines need less leading.
THE COLUMN

“The column is a ‘pillar’ of continuous body type. Most publications have two to five columns.

The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading.

THE COLUMN

“The column is a ‘pillar’ of continuous body type. Most publications have two to five columns.

The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading.

THE COLUMN

“The column is a ‘pillar’ of continuous body type. Most publications have two to five columns.

The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading. The column is a pillar of continuous body type. Most publications have two to five columns. Ideally, each column should be between 5 and 10 words wide at the number of words per line increases to make reading fast and comfortable. Short lines need less leading.

Your master page should contain the grid to guide you in your page layout. Put in only the repeat elements like folios, running heads or boxes when planning your master page. A good guide to leading is that the wider the column the more leading we give to the type. The typeface should be smaller for narrow column.
Horizontal scaling in Freehand 3.1, PageMaker 4.2 or QuarkXPress 3.0 stretches or condenses text by percentage. Type condensing or expansion is always fun to play with on the MAC. Take care to ensure that your printed message is readable (unless you intentionally plan to tease your readers). Use the original unstretched face as it is specially designed to maintain its readability.
Distorting type can add drama and visual impact. Do not go for effect for effect sake but ensure that such manipulation is appropriate to the task or project. Check for readability too unless your intention is to use type to create patterns. TypeStyler has a palette of 70 defaulted styles and shapes techniques. You can also customise the style or pattern-fill to suit your purpose. The above effects were done using TypeStyler 1.5.
These nine letters are created with FreeHand 3.1.
• type a letter of your choice • clone using Command + = • then rotate by using the Rotation tool to the desired position • duplicate using Command + D to create the circular shape as illustrated here

• type text • clone using Command + = • using Reflection tool, click horizontal axis • convert reflected text to paths • graduate by using Fill and line in Attributes menu • repeat process for the above reflected effect

• type in text • convert to paths from Type menu • split element from Element menu • place each letter overlapping another one at a time • then join all letters using Joint elements in Element menu
MAC-graphics®

Technical Note: FreeHand 3.1 • draw an outline of Chaplin face, making sure that the path is closed • using the Text tool, type your text in the dialog box, specifying the font, size and leading • place text block over the image outline • select the text and choose Cut from Edit menu • select the outline and choose Paste inside from the Edit menu • go to Fill and line from the Attributes menu and choose None for the line weight • click OK
Graphic designers generally are careful not to overdress their design. Special effects, as the name implies, should be used for special occasions only and therefore with caution. Do not be enticed into using effects for effects' sake. The final objective is the aesthetic appeal and clarity of your message. Type can be shaped to fit circle, rectangle or any path that you can draw. You can also play with the positive and negative of type thereby providing counter-weight or contrast. Type can also be slanted in either direction to provide contrastive texture to your body of type. Used with care, special effects can have clarity and strong visual impact. Used indiscriminately, it can create visual chaos.

Technical Note: FreeHand 3.1 • draw a small circle • next draw three or more circles, increasing radius of each, ungrouping all of them • align circles on alternate top and bottom using the Alignment command in Elements menu • cut each circle in half at top and bottom points using Knife tool • remove half circles you do not need • select remaining half circles two at a time and join them using Join Elements command in the Elements menu • select text and spiral, bind them using Join Elements command.
When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated.

When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated.

When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated.

When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated.

When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.
Positive type on different tints, Page 38

Tint consists of dots of a color (usually process color). The size and number of dots within a specified area determine the shade or value of the color. Tint or screen is calibrated from 5% to 100% as shown in our process color charts. When limited to 1- or 2-color printing, using tint is one way of adding ‘color’ to an otherwise stark solid color on your pages. You can apply tint to type, lines, boxes or any other shapes or scanned images that you have on the MAC.
The choice of type size against varying screen percentage as a background affects legibility or clarity of type. The balance between the size of type and screen background (for 'type-efficiency' or the desired mood of the message) is the task of a good graphic designer. The examples above show solid black type on 20%, 30%, 40%, 50%, 60%, 70% of black tint background. The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch.
Positive type on different tints

Technical Note: FreeHand 3.1 • draw three rectangles side by side on each page • go to Fill and line in the Attributes menu, specifying the tint value • define type area with the Text tool and type text in the dialog box • specify your font, point size, etc (Note: Typeface used above – Helvetica Light, Helvetica, Helvetica Bold, Helvetica Black • point size: 7, 8, 9, 10 points)
The evenness of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen backgrounds. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The evenness of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The evenness of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The evenness of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not
Helvetica 7 point  The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch.

Helvetica 8 point  The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch.

Helvetica 9 point  The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch.

Helvetica 10 point  The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch. The 'evenness' of the 150 line screen makes black type easy to read when printed over it. The problem only arises when the type gets progressively smaller. It is therefore not advisable to use small black type on screen background. If you have to, try a bold sans serif face like Helvetica. Small reverse white type on light screen background of 20% black is difficult to read. Make your selection but try to use a fine line screen of not less than 133 lines per inch.

Background: tint value 50% black  60% black  70% black

Most white text works well with black screen value of 50% and above as illustrated here. For best results, it is best to avoid script face, fine serif face e.g. Bodoni or thin face, unless the type size is big enough.
When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. • When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ※ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ● When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ♦ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ♤ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ♦ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ❘ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ♣ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ♤ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ♤ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. ♤ When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated.
When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines per inch, the structure of the typeface, especially when it is 8 points and smaller, will break up. Check the good and bad results as illustrated. When you have screen type in 175 lines, you can hardly notice the dots. But when the type has a screen of 35 lines, you can hardly notice the dots. But when the type has a screen of 35 lines.

Tint value: 30 black Screen rule: 133 lpi
Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.
Screen type is another way of adding color to type. The legibility of type depends on its size and its contrast value to its background. For example, you have a screen type of 70% on a 10% screened background. This palette gives you an idea of its legibility rating in positive and negative screen type.

Text tint value: 10% black

Technical Note: FreeHand 3.1 • use Rectangle tool and draw two rectangles • click Attributes and select Basic from Fill and line menu • fill both rectangles with 100% black • select Text tool and type your text in the dialog box, specifying the fonts (Helvetica), size (7 and 9 points respectively) and leading • highlight text block, select Type specs in the Type menu and specify your tint value • click OK
Screen type on screen background needs to be handled with extra care. Make sure you have proofs to confirm legibility before printing. The contrast element must be present to make it legible.
Technical Note: FreeHand 3.1 • draw your tall rectangular boxes for the background tint • click Attributes and specify the tints from the Fill and line menu • type in your text • select tints for the text from the Type specs sub-menu in the Type menu • click OK
Halftone image in type. Page 58

Green

Type on halftone image. Page 50

When using type on image, always try to integrate the text with the image producing a 'unifying whole'. If your type is black, select a lighter area in the image (preferably evenly colored). It is not easy to communicate your message on a 'noisy' background, i.e., an area with both white (highlights) and darkness (shadows). This is sometimes overcome by incorporating a drop-shadow on the type. Whether your type is reverse white or black or colored, graduated or patterned, your background on any image line or halftone should provide ample contrast for the text to be read easily. When using type on image, always try to integrate the text with the image producing a 'unifying whole'. If your type is black, select a lighter area in the image (preferably evenly colored). It is not easy to communicate your message on a 'noisy' background, i.e., an area with both white (highlights) and darkness (shadows).
One criterion to successful graphic design is the way text and images are integrated as a unifying whole. Graphic software is so sophisticated today that type and images can be mutated in so many ways. Adobe Photoshop, an image processing tool, allows lots of creative freedom. The possibilities are limited only by your imagination and innovativeness. It is important to note as well that production control can also affect the final look of your work. You need to comprehend tint or screen (Chapter 2) and line screen (Chapter 5).
When using type on image, always try to integrate the text with the image projecting a unifying whole. If your type is black, select a lighter area in the image (preferably evenly colored). It is not easy to communicate your message on a 'noisy' background, i.e. an area with both white (highlights) and darkness (shadow). This is sometimes overcome by incorporating a drop-shadow on the type. Whether your type is reverse white or black or colored, graduated or patterned, your background on any image, line or halftone should provide ample contrast for the text to be read easily.

Photograph screened to 80% black

When using type on image, always try to integrate the text with the image projecting a unifying whole. If your type is black, select a lighter area in the image (preferably evenly colored). It is not easy to communicate your message on a 'noisy' background, i.e. an area with both white (highlights) and darkness (shadow). This is sometimes overcome by incorporating a drop-shadow on the type. Whether your type is reverse white or black or colored, graduated or patterned, your background on any image, line or halftone should provide ample contrast for the text to be read easily.

Photograph screened to 60% black
When using type on image, always try to integrate the text with the image projecting a unifying whole. If your type is black, select a lighter area in the image (preferably evenly colored). It is not easy to communicate your message on a 'noisy' background, i.e. an area with both white (highlights) and darkness (shadow). This is sometimes overcome by incorporating a drop-shadow on the type. Whether your type is reverse white or black or colored, graduated or patterned, your background on any image, line or halftone should provide ample contrast for the text to be read easily.

When using type on image, always try to integrate the text with the image projecting a unifying whole. If your type is black, select a lighter area in the image (preferably evenly colored). It is not easy to communicate your message on a 'noisy' background, i.e. an area with both white (highlights) and darkness (shadow). This is sometimes overcome by incorporating a drop-shadow on the type. Whether your type is reverse white or black or colored, graduated or patterned, your background on any image, line or halftone should provide ample contrast for the text to be read easily.

When using type on image, always try to integrate the text with the image projecting a unifying whole. If your type is black, select a lighter area in the image (preferably evenly colored). It is not easy to communicate your message on a 'noisy' background, i.e. an area with both white (highlights) and darkness (shadow). This is sometimes overcome by incorporating a drop-shadow on the type. Whether your type is reverse white or black or colored, graduated or patterned, your background on any image, line or halftone should provide ample contrast for the text to be read easily.

When using type on image, always try to integrate the text with the image projecting a unifying whole. If your type is black, select a lighter area in the image (preferably evenly colored). It is not easy to communicate your message on a 'noisy' background, i.e. an area with both white (highlights) and darkness (shadow). This is sometimes overcome by incorporating a drop-shadow on the type. Whether your type is reverse white or black or colored, graduated or patterned, your background on any image, line or halftone should provide ample contrast for the text to be read easily.
Tint type on halftone requires sufficient contrast to communicate the message. It is important to consider the two elements, i.e., photograph and text, and try to integrate them to form a visually satisfying composition. On these two pages we changed the photograph from its original value of 100% and reduced it to 80%, 60%, 40% and 20% respectively. The 18-point display type is fixed at Helvetica 40% black while the 9-point tint text is fixed at 60% black.

Photograph screened to 80% black

Photograph screened to 60% black

Reverse white
Tint type on halftone requires sufficient contrast to communicate the message. It is important to consider the two elements, i.e., photograph and text, and try to integrate them to form a visually satisfying composition. On these two pages we changed the photograph from its original value of 100% and reduced it to 80%, 60%, 40% and 20% respectively. The 18-point display type is fixed at Helvetica 40% black while the 9-point tint text is fixed at 60% black for top text, 40% black for middle text and in reverse white for bottom text.

Text: 40% B

60% B

40% B

Reverse white

Photograph screened to 40% black

Photograph screened to 20% black

Technical Note: FreeHand 3.1 • place your scanned image in FreeHand file • go to Basic in the Fill and line sub-menu and specify the tint percentage • key in the type and size (Helvetica 9 points) • click OK
It is unlikely that type on-line art will be legible because of the black and white background. We suggest that you concentrate your text on a dark or white area, or any evenly colored background. To overcome this problem we can use a second color for the line art. The example illustrates how type in varying sizes respond to second color. The type size starts from Helvetica 8 points to 23 points. Bold type will be more legible. Tint type can give more ‘color’ (shade of gray) to your work, but watch out for clarity. When using second color, select one in the middle tone that will be legible when you print black type or when you want to use reverse white type. It is unlikely that type on-line art will be legible because of the black and white background. We suggest that you concentrate your text on a dark or white area, or any evenly colored background. To overcome this problem we can use a second color for the line art. The example illustrates how type in varying sizes respond to second color. The type size starts from Helvetica 8 points to 23 points. Bold type will be more legible. Tint type can give more ‘color’ (shade of gray) to your work, but watch out for clarity. When using second color, select one in the middle tone that will be legible when you print black type or when you want to use reverse white type.
It is unlikely that type on line art will be legible because of the black and white background. We suggest that you concentrate your text on a dark or white area, or on any evenly colored background. To overcome this problem we can use a second color for the line art. The example illustrates how type in varying sizes respond to second color. The type size starts from Helvetica 8 points to 20 points. Bold type will be more legible. Tint type can give more color (shade of gray) to your work, but watch out for clarity. When using second color, select one in the middle tone that will be legible when you print black type or when you want to use reverse white type. It is unlikely that type on line art will be legible because of the black and white background. We suggest that you concentrate your text on a dark or white area, or any evenly colored background. To overcome this problem we can use a second color for the line art. The example illustrates how type in varying sizes respond to second color. The type size starts from Helvetica 8 points to 20 points. Bold type will be more legible. Tint type can give more ‘color’ (shade of gray) to your work, but watch out.

Technical Note: PageMaker 4.2 • draw a rectangular box and placed your scanned TIFF image • go to Image control in Element menu, select the Screened button and specify 45° for the angle and 150 lines per inch • type in your text using the Text tool, specifying the type sizes and color • click OK
It is unlikely that type on line art will be legible because of the black and white background. We suggest that you concentrate your text on a dark or white area, or any evenly colored background. To overcome this problem we can use a second color for the line art. The example illustrates how type in varying sizes respond to second color. The type size starts from Helvetica 8 points to 20 points. Bold type will be more legible. Tint type can give more ‘color’ (shade of gray) to your work, but watch out for clarity. When using second color, select one in the middle tone that will be legible when you print black type or when you want to use reverse white type.

It is unlikely that type on line art will be legible because of the black and white background. We suggest that you concentrate your text on a dark or white area, or any evenly colored background. To overcome this problem we can use a second color for the line art. The example illustrates how type in varying sizes respond to second color. The type size starts from Helvetica 8 points to 20 points. Bold type will be more legible. Tint type can give more ‘color’ (shade of gray) to your work, but watch out for clarity. When using second color, select one in the middle tone that will be legible when you print black type or when you want to use reverse white type.

It is unlikely that type on line art will be legible because of the black and white background. We suggest that you concentrate your text on a dark or white area, or any evenly colored background. To overcome this problem we can use a second color for the line art. The example illustrates how type in varying sizes respond to second color. The type size starts from Helvetica 8 points to 20 points. Bold type will be more legible. Tint type can give more ‘color’ (shade of gray) to your work, but watch out for clarity. When using second color, select one in the middle tone that will be legible when you print black type or when you want to use reverse white type.

Black type on a tint color image is clearer provided the second color used is not too dark. Any tint type of 40% black and below needs to be handled with care. There are acetate tint type devices in black and process color in the marketplace for you to overlay on a color image to test its legibility.
It is unlikely that type on line art will be legible because of the black and white background. We suggest you concentrate your text on a dark or white area, or any evenly colored background. To overcome this problem we can use a second color for the line art. The example illustrates how type in varying sizes respond to second color. The type size starts from Helvetica 8 points to 90 points. Bold type will be more legible. Tint type can give more 'color' (shade of gray) to your work, but watch out for legibility. When using second color, select one in the middle tone that will be legible when you print black type or when you want to use reverse white type. It is unlikely that type on line art will be legible because of the black and white background. We suggest you concentrate your text on a dark or white area, or any evenly colored background. To overcome this problem we can use a second color for the line art.

Technical Note: PageMaker 4.0 - draw a rectangular box and placed your scanned TIFF image. Go to Image control in Element menu, select the Screened button and specify 45° for the angle and 150 lines per inch. Type in your text using the Text tool, specifying the type sizes and tint value. Click OK.
Type need not be just plain black or colored. Liven up your display type by including halftone images within it. Software such as Adobe Photoshop or Aldus FreeHand let you incorporate both black and white or color images within the type itself. It can be a good technique to give your design that extra visual impact. Ensure that the typeface chosen is thick, bold and contrasty enough to stand out.
Technical Note: First create outline letters in Adobe Illustrator 3.0 and save as EPS file • scan image and save as grayscale TIFF • open the scan in Photoshop • copy entire image onto the clipboard and then erase it • place the EPS file and scale to size • while letters are still selected, use the Paste inside command in the Edit menu and paste the image inside the letters • use the Color picker and set 50% Cyan • fill the selection using the Fill command in the Edit menu (set Opacity between 30%-50%)
Technical Note: First create outline letters in Adobe Illustrator 3.0 and save as EPS file. Scan image and save as grayscale TIFF. Open the scan in Photoshop. Copy the entire image onto the clipboard. Select the lower quarter of the image and delete it. Place the EPS file and scale to size. While the letters are still selected, use the Paste inside command in the Edit menu and paste the image inside the letters. Use the Color picker and set 50% Cyan. Fill the selection using the Fill command in the Edit menu (set Opacity between 30%-50%).
Technical Note: First create outline letters in Adobe Illustrator 3.0 and save as EPS file. Scan image and save as grayscale TIFF. Open scan in Photoshop, copy the entire image onto the clipboard. Place the EPS file and scale to size. While the letters are still selected, use the Paste inside command in the Edit menu and paste the image inside the letters. Go to the levels command in the image menu and lighten the image inside the type. Use the Color picker and set 50% Cyan. Fill the selection using the Fill command in the Edit menu. Stroke the selection with a line thickness of 2-4 pixels using the Stroke command in the Edit menu.
Tint rule on positive/negative background. Page 72

Frames on positive/negative background. Page 66

Rule pattern on tint. Page 74
Rules (or lines as in your MAC) are a very useful graphic element to emphasise or demarcate a word or a page. Rules can be of varying thickness from 0.1 to 500 points. Rules can come in various styles, colors or shades. Rules can be created with pre-defined desktop patterns or postscript patterns. Postscript lines do not appear on screen. You can see them in print on a postscript printer.
Rules are extremely useful graphic elements for creating contrast and movement. When clustered together, whether viewed in negative or positive, they have a dynamic luminous quality about them. Secondary to the rules are dotted and dash lines. Such lines are often used to indicate scoring or folding marks. They can also be used as lines for graphs or charts.
The above illustrates the 3 different joins (miter, round and beveled) and 3 different caps (butt, round and square).
There are many ways to use frames. Frames are normally used as picture boxes for graphics or pictures. You can thicken the line and use it as a graphic frame around your picture. On the opposite page, you can create a large variety of decorative frames from QuarkXPress.
Technical Note: QuarkXPress 3.0 • draw rectangular boxes using the Box tool • go to Frame in the Item menu and specify 15 points for Width, black for Color and 100% for Shade • repeat this process for the negative frames, this time specifying white for Color (Note: background color should be None in the Modify menu or Command + M) • click OK
Rules and shapes

Black rule on tint background

Black rules on most screen backgrounds look legible. 0.5 point rules only start to deteriorate with 60% black background and above.

Technical Note: FreeHand 3.1 • draw the eight basic rules using the Line tool and specify the weight from the Attributes menu • draw the rectangular boxes • specify your tint value from the Fill and line menu • click OK • send rectangular box to back by depressing Command + B
<table>
<thead>
<tr>
<th>12.0 pts</th>
<th>8.0 pts</th>
<th>6.0 pts</th>
<th>4.0 pts</th>
<th>2.0 pts</th>
<th>1.0 pt</th>
<th>0.5 pt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hairline</td>
<td>Background tint: black 5%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10%</td>
<td>15%</td>
<td>20%</td>
<td>25%</td>
<td>30%</td>
<td>35%</td>
<td>40%</td>
</tr>
</tbody>
</table>
The line screen is 150 lines per inch. White rules on screen background are commonly used. 12-point rules appear all right on almost any shaded background but Hairline to 1-point rules need to be handled with the right background as legibility can be affected.

Technical Note: FreeHand 3.1 - draw the eight basic rules using the Line tool • click Attributes and specify the line weights and white color from the Fill and line sub-menu • draw the rectangular boxes, specifying your tint values from the Fill and line sub-menu in the Attributes menu • click OK • send rectangular box to back by depressing Command + B
These tint rules are set in 150 lines on a black background. The differing shades in 10% black increment on white rules provide you with a palette to make a choice.

Technical Note: FreeHand 3.1 • draw the eight basic rules using the Line tool • go to Fill and line in Attributes menu and specify the line weights and gray values • draw the rectangular boxes, click Attributes and select black from the Fill and line sub-menu • send rectangular box to back by depressing Command + B
There are so many possibilities with rules. The 'square' rules here are created by overlapping white, tinted and graduated square shapes — one over the other, exposing a small part of the bottom square.
Technical Note: FreeHand 3.1 • draw the image on the left page by creating a series of overlapping white, tint or graduated squares • centralise all the elements by using Alignment in Element menu • click OK
Tint value on different line screens. Page 80
Line screen (or sometimes called screen ruling or screen lines) is a printing term that refers to a technique used for breaking up halftone images (e.g. black and white photograph) into printable dots. The denser dark area of the photograph will have bigger black dots and the lighter area will have tiny black dots. Observe and study a printed black and white halftone photograph in any book with a magnifier or loupe and you can see the different dot structure. Line screen is measured in lines per inch (lpi). A normal laser printer with a 300 dots per inch (dpi) is about 50 lpi. As you can see from the following pages, the bigger the line screen (175 lpi) the finer the result. Programs like QuarkXPress, FreeHand and PageMaker allow you to define the line screen.
This exercise demonstrates the characteristics of the line screen of 133 lines (this page) and 150 lines per inch (page 79). The screen is magnified 10 times for close scrutiny. If you study the angle of the dots, you probably will notice the screen angle of 45°. Cyan is angled at 105°, magenta at 75°, yellow at 90° and black at 45°. This dot arrangement, side by side and not overlapping each other, is necessary to produce the desired color. If all dots sit on top of each other, the result is dark gray. If you close one eye and view the two pages together, you will find that the tone/value is similar although the line screens differ. Moiré pattern (a disturbing repeat pattern) will also appear in improper angling of screen.
Technical Note: FreeHand 3.1

- draw a quarter circle with the Combination tool
- activate your image
- select Fill and line from Attributes menu
- specify your tint value
- go to Attributes menu
- select Halftone screen, specifying Default for Screen type, 45% for Screen angle and Screen ruling of 20 lines per inch (133 lines x 10% to achieve a 10% magnification. The magnification will not be shown on screen until it is printed.)
The 'smoothness' of tint depends greatly on the line screen selected for the purpose. The finer the line screen, e.g. 175 line screen, the finer the print dots. 175 lines refer to 175 lines per inch. Coarse line screen of 65 to 100 lines is used for printing newspaper, 133 lines for woodfree paper (Simile) as in books and 150 lines and above for fine printing on art paper. Pages 80 and 81 illustrate line screens of 35, 65, 133 and 150 lines per inch respectively.
Technical Note: FreeHand 3.1
• draw the boxes
• go to Fill and line in the Attributes menu and specify your tint values
• scan your image with the GrayScale scanner
• save as TIFF image
• open FreeHand and Place in your TIFF image
• go to Attributes menu, select Halftone screen and specify Default for Screen type,
  45° for Screen angle and Screen ruling of 150 lines per inch
These pages (pages 82, 83) illustrate how graduation tint (from 5% black to 100% black) appear in different line screens of 35 and 65 lines per inch using the Halftone screen command in FreeHand.
Technical Note: FreeHand 3.1

- Draw the individual graphic block of the triangle.
- Go to Graduated in the Fill and line sub-menu in the Attributes Menu, specify the tint values and angle direction by adjusting the hand of the 'clock'.
- Select Halftone screen from Attributes menu and specify the Screen type, angle and ruling.
- Click OK.

(Graduation can only be done with a graphic block, starting from point A to B.)
The pages here illustrate graduation in different directions within various shapes. Page 84 uses Linear graduation and page 85 uses Logarithmic graduation. Linear gives graduation of equal increments whereas Logarithmic begins with a narrow graduation and progresses in wider increments.
Technical Note: FreeHand 3.1 - Draw a rectangle, go to Fill and line in the Attributes menu, choose Graduated in the Fill sub-menu and adjust the direction of graduation, percentage value of tint from beginning to end point and taper angle. Construct your shape, place outline shape over rectangular box, activate the rectangular box, go to Edit menu and choose Cut. Activate the shape, go to Edit menu and choose Paste inside.
Line art is artwork e.g. illustration, etching, map in one solid tone — black. Unlike the halftone in a black and white photograph where the tonal value is subtle and well-blended, creating a three-dimensional visual form, line art is in stark black and white or any other solid color. The use of line art on the MAC is usually the beginning of your artistic journey as you can manipulate the shape, lay tint, color, graduate or transform it completely into a different graphic image. Line art can either be drawn on the MAC or imported onto the MAC using a scanner. There is an enormous amount of scanned line art (or clip-art as is commonly known) available in the market place.
These are the desktop patterns as arranged in the FreeHand program. The patterns are suitable for graphs, maps or charts. Patterned fills are most effective in black and white. You can use the patterns as they are or even edit them.
Desktop pattern on positive / negative

Technical Note: FreeHand 3.1 • draw the boxes • go to Fill and line in the Attributes menu • select Patterned from the Fill sub-menu • choose the patterns of your preference
PostScript is a page-description language. Such a command can be found in FreeHand's Fill and line menus. You can open the Custom dialog box and use the pre-defined PostScript fills. You can even invent your own graphics by writing your own PostScript procedures.
Technical Note: FreeHand 3.1 • draw your image with the Combination tool • choose Custom fill from Fill and line in the Attributes menu and select the effect of your preference • go to the Text tool and type text in the dialog box, specifying font, size, leading • click OK (Note: PostScript pattern will not display on your screen. Print document to see effect. For more information on creating your own PostScript effects, refer to FreeHand User Manual.)
FreeHand allows scaling of scanned or drawn images both horizontally and vertically. Such manipulation can change or exaggerate the form and it can be distorted beyond recognition.

Technical Note: Microtek MSF 300Z, VersaScan, FreeHand 3.1
* scan your line art in VersaScan and save as TIFF image
* open FreeHand and place the scanned image
* select Duplicate from Edit menu
* go to Tool box, select the Scaling tool while holding down the Option key
* key in the horizontal or vertical percentage
* click OK (Note: always go back to the original if you need to re-scale more images.
You can also do scaling by dragging the element’s handles.)
Images can be skewed horizontally, vertically, both horizontally and vertically in different proportions, or uniformly in both directions. Such exaggerations can be fascinating. It is advisable not to distort them beyond recognition.
Forming transparent holes. It is possible to create a third dimension in your drawings with FreeHand that allows you to see through the filled shape. This can be easily done by Joining elements or Command + I from the Element menu.
This is a close-up of the blending path as illustrated on page 97. To achieve that very smooth blending, many steps of blends were done.
Technical Note: FreeHand 3.1 • scan in the musical instruments from magazine/book • trace the drawing using FreeHand • select areas to be blended • click two reference points and choose Blend in the Element menu • blend as many steps as required and click OK • the areas between the two points will be blended • repeat the process
This is an interesting exercise in blending two colors. The softness and subtle colors of the roses are FreeHand drawn. Again the key images are drawn and duplicated with minor changes made to the petals or leaves.
Technical Note: FreeHand 3.1 • scan a line drawing of the fish and save in TIFF format • open FreeHand and trace over the line drawing • select the areas to be blended • click two reference points and choose Blend in the Element menu • blend as many steps as required and click OK • the area between the two points will be blended • repeat the process
If you do wall paper, packaging and wrapper design, this technique is very useful. Having done the master motif, you can tile them in all directions as a fill.
Technical Note: FreeHand 3.1 • draw a rectangular box • create an image to use as a tile • go to Cut or Copy command in the Edit menu • activate the rectangular box • choose Fill and line from Attributes menu and select Tiled from the Fill pop-up menu • click Paste in button to paste the tiled image onto the dialog box • specify the Scale, Angle and Offset options • click OK (Note: paint-type or TIFF image, an EPS element or another tiled fill cannot be used to create the tiled fill effects.)
Line art is a stark black and white image with no grayscale. By using different fill in spot color or black, different moods can be created.
Technical Note: FreeHand 3.1

- place the scanned TIFF image in the rectangular boxes
- select Element Info and click on the Transparent button
- select Color from the Attributes menu
- go to Fill and line in Attributes menu
- fill image and boxes with the desired percentage (or different Fill characteristics e.g. Graduated, Patterned, Radial, Custom, etc.)
- send TIFF image to front
Using exclusively black tint for the image and background will not pose any registration problem. The subtle and 'blurred' image is often used as backdrop with black text overprinted.
Technical Note: FreeHand 3.1 - draw the rectangular boxes for the background • go to Fill and line in the Attributes menu, specifying the tint values • place in your scanned images and select your tint percentage
Line screen and halftone image. Page 108

Halftone patterns. Page 113

Duotone and tritone grayscale re-mapping. Page 118

Line conversion from halftone. Page 110
Halftone is a continuous tone image, such as a photograph, slide, print or drawing. Technically, a continuous tone image cannot be printed until it is broken down into dots. Halftone can be reproduced right on your desktop. You can capture digitised images with a scanner, touch them up in a page layout or an image re-touching program and specify your line screen and angle. The following pages illustrate how the various line screens appear.
Stamps use very fine line screen (200 to 300 lines) to achieve a printed result with excellent detail. Glossy coffee table books or magazines may use 175 to 200 lines. Most newspapers, on the other hand, use 65 to 100 lines. One will almost always be tempted to use the finest line screen. Fine line screen on newsprint or high absorbency paper will give patches of black because the print dots will spread and link together.
Halftone image

Line screen and halftone image

Technical Notes: Mac-GrayScan 1.6, FreeHand 3.1
- scan your picture as a GrayScale image
- select Acquire from the Scan menu, click on the PreScan button
- your selection will appear on the screen
- drag the mouse over your selected area
- click Scan
- once scanning is completed, save the file
- open FreeHand 3.1 and place your scanned image
- go to Halftone screen in Attributes menu, specifying the Screen type, angle and ruling
- click OK

Line screen: 133 lines per inch (lpi)
150 lpi
175 lpi
Scanned grayscale image can be transformed by FreeHand to various effects like Gray-level, Negative, Posterization, Solarization and Line shot. Other page layout applications such as Aldus PageMaker or QuarkXPress also offer similar image control commands.
Technical Note: Mac-GrayScan 1.6, FreeHand 3.1
- scan image in GrayScale
- place your scanned TIFF image in the FreeHand file
- select the element you want to modify
- go to Element info or Command + 1 from the Element menu
- set options (Gray-level, Negative, Posterize, Solarize or Line shot) in the Image dialog box
- click OK
The halftone images are converted into line art. Here we use VersaScan Plus™ to convert the halftone into various line effects.
Technical Note: VersaScan 2.1™ • scan halftone photograph using VersaScan 2.1™ • choose Acquire in the Scan menu • select Halftone, go to Halftone Grain and click the dialog box to choose from a selection of desired characteristics of scanned results e.g., 8x8: Horizontal line • prescan image and crop photograph with the Pointer tool • scan • save as TIFF image
Posterization can be done in any program that can control grayscales. It reduces the 16 gray levels to only 4. An image with white, black and one intermediate gray tone produces a two-step posterization (page 114). An image with white, black and two intermediate gray tone produces a three-step posterization (page 115). Process colors are used to illustrate the examples as shown on these pages but a combination of spot colors can also produce interesting results.
Three-step posterization (magenta, yellow, black)  Three-step posterization (cyan, magenta, yellow)

Technical Note: Mac-GrayScan 1.6, FreeHand 3.1 • scan your halftone image in GrayScan • open FreeHand and place the scanned image • go to Element info in Element menu • set options in the Image dialog box and select the Screened button • choose Halftone screen from Attributes menu, specifying the Screen type, angle and ruling (please see page 78 for more information on Line screens) • click OK (Note: the above examples were assembled from two and three line shots with the settings as shown.)
Duotone is a darkroom process of converting a black and white photograph into two tones or two, three and even four colors. Subtle mood changes can be achieved with different combination of colors. It is critical to start with a good photograph with a wide tonal range, i.e., from highlight to mid-tone to dense shadow. The example on page 116 was achieved by using gray map bars to manipulate the Lightness and Contrast, whereas for page 117 process colors from the Color dialog box were applied directly.
Technical Note: Mac-GreyScan 1.6, FreeHand 3.1 • place your scanned image in the FreeHand file • go to Fill and line in Attributes menu and select your desired process or spot colors • click OK
Two-step re-mapping (magenta, yellow)

Two-step re-mapping (cyan, magenta)

Re-mapping grayscale into separate colors requires some degree of visualization skills and a sensitive feel for colors. For testing purpose, we mapped each step in color on a separate transparent OHP acetate. To get a close final result, the OHP transparencies were overlapped.
Three-step re-mapping (cyan, magenta, yellow)

Three-step re-mapping (magenta, yellow, black)

Technical Note: Mac-GrayScan 1.6, FreeHand 3.1 • the technical process for duotone and tritone re-mapping is the same as that on pages 116 and 117 (Note: to re-map the grayscale, the gray map bars were re-set individually by clicking them in each column. The above effects were created after much experimentation and visualization.)
Spring Pools

These pools that, though in forests, still reflect
The total sky almost without defect
And like the flowers beside them, chill and shiver;
Will like the flowers beside them soon be gone,
And yet not out by any brook or river,
But up by roots to bring dark foliage on.

The trees that have it in their pent-up buds
To darken nature and be summer woods –
Let them think twice before they use their powers
To blot out and drink up and sweep away
These flowery waters and these watery flowers
From snow that melted only yesterday.

Robert Frost
1875–1963

Break, break, break

Break, break, break,
On thy cold grey stones, O Sea!
And I would that my tongue could utter
The thoughts that arise in me.

O well for the fisherman’s boy,
That he shouts with his sister at play!
O well for the sailor lad,
That he sings in his boat on the bay!

And the stately ships go on
To their haven under the hill;
But O for the touch of a vanish’d hand,
And the sound of a voice that is still!

Break, break, break,
At the foot of thy crags, O Sea!
But the tender grace of a day that is dead
Will never come back to me.

Alfred, Lord Tennyson
1809–1892

Ghosting halftone is reducing the tonal value of an image. This is often done when using type on the image for the text to be read easily. The images were produced as duotone (page 120) or tritone (page 121) separations with the Lightness adjusted up and Contrast adjusted down.
Today's Special

Handmade Tortellini
served with Avocado Chive Sauce
$9.95

Grilled King Mackerel
topped with crunchy sauteed almonds
and cocktail or tartar sauce
$12.95

Appetizers
Garlic Bread $1.95
Avocado Cocktail with Fresh Salsa $3.95
Chicken Salad Platter $5.50

Soup
Cream of Chicken Soup $4.00
Tomato Soup with Gin $3.50

Meats and Poultry
Eastern Veal Cutlet, Milanese $10.95
Rump Steak with mixed Salad $11.95
Filets Mignon in Pepper Sauce $11.95

Sandwiches and Salad
Omelette Sandwich $2.95
Deluxe Sandwich $3.50
Salad Nicoise $3.95
Spinach and Bacon Salad $2.95

Beverages
Freshly Brewed Coffee $1.25
Darjeeling Tea $1.95
Hot Chocolate $1.25
Milk $1.25

Technical Note: Mac-GrayScan 1.6, FreeHand 3.1 • scan halftone image in GrayScale • place your scanned image in the FreeHand file • go to Element info in the Element menu • set options in the Image dialog box and select the Screened button • go to Halftone screen in Attributes menu, specify the Screen type, angle and ruling • define your text area and use the Text tool to type in the text, and specify your desired font, size and leading • display the text within the 'ghosting' halftone image
How to use the color scale chart. Page 124

Selected process color (20% C, 90% M, 40% Y)

Percentage of 1st process color

Percentage of 2nd process color

1st process color

2nd process color

Fixed or base color (40% Y)

Cyan

Magenta

Cyan and Yellow

Cyan and Magenta

Cyan, Magenta and Yellow

Cyan and Black

Magenta and Black

Yellow and Black

Cyan, Magenta and Black

Cyan, Yellow and Black

Magenta, Yellow and Black

COLOR IN GRADUATION

One-color graduation

Two-color graduation

Three-color graduation

COLOR ON WHITE, GRAY AND BLACK

Yellow on white, gray and black

Orange on white, gray and black

Red on white, gray and black

Violet on white, gray and black

Blue on white, gray and black

Green on white, gray and black

Gray on white, gray and black

Process means to convert raw materials to useful products. The raw materials in our case refer to the four basic printing ink (Cyan, Magenta, Yellow, Black) which is called Process Color. When the colors are combined in varying percentages, a myriad of colors can be reproduced. The charts on the following pages provide a very useful reference for the selection of colors based on CMYK (Cyan, Magenta, Yellow, Black).
Process Color  Color images have to be color separated before printing. This process involves scanning the color photographs or slides through high-end color scanners from Hell, Dainippon, Scitex or Crossfield. These machines give excellent results. They break down the color into dots (or halftone dots) of four basic colors (CMYK – Cyan, Magenta, Yellow and Black) called process color. These colors when overprinted in four passes will give a reproduction of the original. There is now hardware for scanning color or grayscale for the MAC. Some of them are Microtek, Sharp, Howtek, Nikon, and BarneyScan. Scanned color images take up a lot of space in your hard disk.

By using a mixture of the process color in different percentages we can create a myriad of hues in varying tone or intensity (brightness). We can thus create flat or graduated color called tint, e.g. a tint of 100% magenta and 100% yellow will produce red. The following pages catalog the range of colors by using tint. For accurate selection of color, view your choice by masking it with the paper window mask provided on the flap of the back cover.

How to use MAC-graphics\textsuperscript{\textregistered} color chart  There are 18,800 two- and three-color tint combinations shown from pages 126 to 219. These are in increments of 5% for each unit. Colors such as orange, pastel or reflex blue cannot be matched using process ink tints. For special colors, it is advisable to use Spot color or Pantone\textsuperscript{TM} color.

Warning: Printing of tint combinations is not always consistent as there are many variables. Some of them are:

- Ink – do you use ink from the same manufacturer?
- Ink laydown – do you have a set sequence of printing the four colors, i.e., CMYK, MCYK, YMCK, etc?
- Dot gain – different presses have different gains in dot size (halftone dot). A gain in dot size will mean an overall darker image.
- Papers and finishes – the absorbency and color of the paper will influence the final color.
- Neighbor color – your selected color will assume different tone value or intensity depending on the colors around it.
- Arrangement of tint images – paper flows in one direction when printing and when you have multiltint images along a path, the image that reaches the ink-roller last will be deprived of colors (it can be any of the CMYK) and often appears weaker. The top right page of Tint A, for example, will be affected by the ink take-off from the large area of Tint B.

The Color Wheel  The 12-hue color wheel is composed of the primary, secondary and tertiary colors. The three primary colors are Red, Yellow and Blue. The secondary colors are made up of two primary colors:

- Red + Blue = Violet,
- Yellow + Red = Orange, and
- Yellow + Blue = Green

The tertiary colors consist of a primary color and a secondary color. For example,
- Yellow + Orange = Yellow-orange,
- Red + Violet = Red-violet, etc.

We can extend the color wheel by going into the value of color, e.g. light to dark, and intensity of color which makes reference to the range from dull to bright color.
Whether you use process color or black and white, the same principles of using line screens apply. It depends on the paper to be used. Newspapers use 65 to 100 line screen per inch and high quality color books use 175 line screen per inch. The above chart illustrates the 'grain' of different process color in different line screens.
<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>60</td>
<td>65</td>
<td>70</td>
<td>75</td>
<td>80</td>
<td>85</td>
<td>90</td>
<td>95</td>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>

**Process Color Scale**

**Technological Information:**

- **Software:** Aldus FreeHand 3.1
- **Hardware:**
  - Mac IIx
  - RAM 8 MB
  - SuperMac
  - Trinitron 19"
  - SuperMac Spectrum PDO
  - 24 bit VideoCard
- **Color Proofing:**
  - QMS ColorScript 100
  - Canon CLC 500
- **Line Screen:**
  - 150 lines per inch
- **Printing:**
  - SpeedMaster
  - 28" x 40" presses with standard process inks
- **Paper:**
  - 128 g matt art
<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Process Color Scale

<table>
<thead>
<tr>
<th>Cyan</th>
<th>Yellow</th>
</tr>
</thead>
<tbody>
<tr>
<td>55</td>
<td>60</td>
</tr>
<tr>
<td>65</td>
<td>70</td>
</tr>
<tr>
<td>75</td>
<td>80</td>
</tr>
<tr>
<td>85</td>
<td>90</td>
</tr>
<tr>
<td>95</td>
<td>100</td>
</tr>
</tbody>
</table>

**Technical Information:**

**Software:**
- Aldus FreeHand 3.1

**Hardware:**
- Mac Irix
- RAM 8 MB
- SuperMac
- Trinitron 19"
- SuperMac Spectrum PDQ
- 24 bit VideoCard

**Color Proofing:**
- QMS ColorScript 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster
- 26" x 40' presses
- with standard process inks

**Paper:**
- 128 g matt art
Technical Information:
Software: Aldus FreeHand 3.1
Hardware: Mac IIfx
RAM 8 MB
SuperMac Trinitron 19"
SuperMac Spectrum PCC
24 bit VideoCard
Color Proofing: OMS ColorScript 100
Canon CLC 500
Line Screen: 150 lines per inch
Printing: SpeedMaster 28" x 40" presses with standard process inks
Paper: 128 g matt art
Process color scale

<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan</td>
<td>Magenta</td>
<td>10 Yellow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Technical Information:

Software: Aldus FreeHand 3.1

Hardware:
Mac IIx
RAM 8 MB
SuperMac Trinitron 19"
SuperMac Spectrum PDO
24 bit VideoCard

Color Proofing:
QMS ColorScript 100
Canon CLC 500

Line Screen: 150 lines per inch

Printing:
SpeedMaster 28 x 40" presses with standard process inks

Paper: 128 g matt art
Technical Information:

Software: Aldus FreeHand 3.1

Hardware:
Mac IIx
RAM 8 MB
SuperMac Trinitron 19"
SuperMac Spectrum PDD
24 bit VideoCard

Color Proofing:
OMS Color/Script 160
Canon CLC 500

Line Screen:
150 lines per inch

Printing:
SpeedMaster 28' x 40' presses
with standard process inks

Paper:
128 g matt art
### Process Color Scale

<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Cyan" /></td>
<td><img src="#" alt="Magenta" /></td>
<td><img src="#" alt="Yellow" /></td>
<td><img src="#" alt="Red" /></td>
<td><img src="#" alt="Orange" /></td>
<td><img src="#" alt="Pink" /></td>
<td><img src="#" alt="Purple" /></td>
<td><img src="#" alt="Blue" /></td>
<td><img src="#" alt="Green" /></td>
<td><img src="#" alt="Gray" /></td>
</tr>
</tbody>
</table>

#### Technical Information:

- **Software:** Aldus FreeHand 3.1
- **Hardware:**
  - Mac IIx
  - RAM 8 MB
  - SuperMac
  - Trinitron 19"
  - SuperMac
  - Spectrum PQ
  - 24 bit VideoCard
- **Color Proofing:**
  - OMS ColorScript
  - 100
  - Canon CLC 500
- **Line Screen:**
  - 150 lines per inch
- **Printing:**
  - SpeedMaster
  - 20" x 40" presses
  - with standard process inks
- **Paper:**
  - 128 g matt art
Technical Information:
Software:
Aldus FreeHand 3.1
Hardware:
Mac IIx
RAM 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PDQ
24 bit VideoCard
Color Proofing:
OMS ColorScript
100
Canon CLC 500
Line Screen:
150 lines per inch
Printing:
SpeedMaster
28" x 40" presses
with standard process inks
Paper:
128 g matt art
<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Cyan.png" alt="Cyan" /></td>
<td><img src="Magenta.png" alt="Magenta" /></td>
<td><img src="35Yellow.png" alt="35 Yellow" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Technical Information:**

**Software:**
Aldus FreeHand 3.1

**Hardware:**
Mac IIfx
RAM 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PDQ
24 bit VideoCard

**Color Proofing:**
OMS ColorScript
100
Canon CLC 500

**Line Screen:**
150 lines per inch

**Printing:**
SpeedMaster 28" x 40" presses with standard process inks

**Paper:**
128 g matt art
<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cyan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Magenta</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>40 Yellow</td>
</tr>
</tbody>
</table>

**Technical Information:**

**Software:**
- Aldus FreeHand 3.1

**Hardware:**
- Mac II fx
- RAM 8 MB
- SuperMac
- Trinitron 19"
- SuperMac
- Spectrum PDO
- 24 bit VideoCard

**Color Proofing:**
- OMS ColorScript
- 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster
- 28" x 40" presses
- with standard process inks

**Paper:**
- 128 g matt art
<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Technical Information:

Software: Aldus FreeHand 3.1
Hardware: Mac IIfx
         RAM 8 MB
         SuperMac
         Trinitron 19"
         SuperMac
         Spectrum PDL
         24 bit VideoCard
Color Proofing: OMS ColorScript 100
                Canon CLC 500
Line Screen: 150 lines per inch
Printing: SpeedMaster
         25" x 40" presses with standard process inks
Paper: 128 g matt art
<table>
<thead>
<tr>
<th>Color</th>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magenta</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50 Yellow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Technical Information:**

- **Software:** Aldus FreeHand 3.1
- **Hardware:**
  - Mac IIx
  - RAM 8 MB
  - SuperMac Trinitron 19"
  - SuperMac Spectrum PDO
  - 24 bit VideoCard
- **Color Proofing:**
  - OMS ColorScript 100
  - Canon CLC 500
- **Line Screen:** 150 lines per inch
- **Printing:**
  - SpeedMaster 28" x 40" presses with standard process inks
- **Paper:** 128 g matt art
<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>60</td>
<td>65</td>
<td>70</td>
<td>75</td>
<td>80</td>
<td>85</td>
<td>90</td>
<td>95</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>Cyan</td>
<td>Magenta</td>
<td>55 Yellow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Technical Information:

Software:
- Aldus FreeHand 3.1

Hardware:
- Mac IIx
- RAM 8 MB
- SuperMac
- Trinitron 19" SuperMac
- Spectrum PDQ 24 bit VideoGard

Color Proofing:
- OMS ColorScript 100
- Canon CLC 500

Line Screen:
- 150 lines per inch

Printing:
- SpeedMaster
- 28" x 40" presses
  - with standard process inks

Paper:
- 128 g matt art
<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Technical Information:

Software: Aldus FreeHand 3.1

Hardware:
- Mac IIfx
- RAM 8 MB
- SuperMac Trinitron 19"
- SuperMac Spectrum PDO 24 bit VideoCard

Color Proofing:
- OMS ColorScript 100
- Canon CLC 590

Line Screen:
- 150 lines per inch

Printing:
- SpeedMaster
- 28" x 40" presses with standard process inks

Paper:
- 128 g matt art
<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cyan</td>
<td>Magenta</td>
<td>65 Yellow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-----------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>60</td>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>75</td>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td>90</td>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Technical Information:**

**Software:**
- Aldus FreeHand 3.1

**Hardware:**
- Mac IIfx
- RAM 8 MB
- SuperMac
- Trinitron 19'
- SuperMac
- Spectrum PDO
- 24 bit VideoCard

**Color Proofing:**
- QMS ColorScript 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster
- 26" x 40" presses with standard process inks

**Paper:**
- 128 g matt art
Process color scale

8

Cyan
Magenta
70 Yellow

Technical Information:
Software:
Aldus FreeHand 3.1

Hardware:
Mac IIfx
RAM 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PQ
24 bit VideoCard

Color Proofing:
QMS ColorScript 100
Canon CLC 500

Line Screen:
150 lines per inch

Printing:
SpeedMaster 28" x 40" presses with standard process inks

Paper:
128 g matt art
### Technical Information:

- **Software:** Aldus FreeHand 3.1
- **Hardware:**
  - Mac IIx
  - RAM 8 MB
  - SuperMac
  - Trinitron 19''
  - SuperMac
  - Spectrum PDQ
  - 24 bit VideoCard
- **Color Proofing:**
  - QMS ColorScript 100
  - Canon CLC 500
- **Line Screen:** 150 lines per inch
- **Printing:**
  - SpeedMaster 20'' x 40'' presses with standard process inks
- **Paper:** 128 g matt art
Technical Information:

Software: Aldus FreeHand 3.1

Hardware: Mac IIX
RAM 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PDQ
24 bit VideoCard

Color Proofing: QMS ColorScript
100
Canon CLC 500

Line Screen: 150 lines per inch

Printing: SpeedMaster 28" x 40" presses with standard process inks

Paper: 128 g matt art
Technical Information:

Software: Aldus FreeHand 3.1

Hardware:
Mac IIx
RAM 8 MB
SuperMac Trinitron 19"
SuperMac Spectrum PDQ 24 bit VideoCard

Color Profiling:
QMS ColorScript 100
Canon CLC 500

Line Screen: 150 lines per inch

Printing:
SpeedMaster 28" x 40" presses with standard process inks

Paper: 128 g matt art
Process color scale

Technical Information:

Software:
Aldus FreeHand 3.1

Hardware:
Mac IIx
RAM 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PDQ
24 bit VideoCard

Color Proofing:
OMS ColorScript 100
Canon CLC 500

Line Screen:
150 lines per inch

Printing:
SpeedMaster 28" x 40" presses with standard process inks

Paper:
128 g matt art
Technical Information:

Software: Aldus FreeHand 3.1

Hardware: Mac IIfx
RAM 8 MB
SuperMac Trinitron 19"
SuperMac Spectrum PDO 24 bit VideoCard

Color Proofing: OMS ColorScript 100
Canon CLC 500

Line Screen: 150 lines per inch

Printing: SpeedMaster 28" x 40" presses with standard process inks

Paper: 128 g matt art
### Technical Information:

**Software:**
- Aldus FreeHand 3.1

**Hardware:**
- Mac IIx
- RAM 8 MB
- SuperMac
- Trinitron 19''
- SuperMac
- Spectrum PDO
- 24-bit VideoCard

**Color Proofing:**
- OMS ColorScript 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster
- 28'' x 40'' presses
- with standard process inks

**Paper:**
- 128 g matt art
<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Technical Information:

Software:
- Aldus FreeHand 3.1

Hardware:
- Mac IIx
- RAM 8 MB
- SuperMac
- Trinitron 19"
- SuperMac
- Spectrum POD 24 bit VideoCard

Color Proofing:
- OMS ColorScript 100
- Canon CLC 500

Line Screen:
- 150 lines per inch

Printing:
- SpeedMaster
- 28" x 40" presses with standard process inks

Paper:
- 128 g matt art

Process color scale

<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
</table>

Yellow

Black
Process color combination for pages 178 to 191 uses cyan, magenta and black. These three colors when used together may present moiré patterns. Most imagesetters
can now resolve the moiré pattern problem.

### Technical Information:

**Software:**
Aldus FreeHand 3.1

**Hardware:**
- Mac IIfx
- RAM 8 MB
- SuperMac
- Tribrion 19'
- SuperMac
- Spectrum PDQ
- 24 bit VideoCard

**Color Proofing:**
- OMS ColorScript 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster
- 28 x 40' presses with standard process inks

**Paper:**
- 128 g matt art
### Technical Information:

**Software:**
- Aldus FreeHand 3.1

**Hardware:**
- Mac IIfx
- RAM 8 MB
- SuperMac
- Trinitron 19''
- SuperMac
- Spectrum PDQ
- 24 bit VideoCard

**Color Proofing:**
- OMS Color/Script 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster 28'' x 40'' presses with standard process inks

**Paper:**
- 128 g matt art
Technical Information:

Software:
- Aldus FreeHand 3.1

Hardware:
- Mac IIx
- RAM 8 MB
- SuperMac
- Trinitron 19''
- SuperMac
- Spectrum PDQ
- 24 bit VideoCard

Color Proofing:
- OMS ColorScript 100
- Canon CLC 500

Line Screen:
- 150 lines per inch

Printing:
- SpeedMaster
- 28'' x 40'' presses with standard process inks

Paper:
- 128 g matt art
### Process Color Scale

<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Cyan" /></td>
<td><img src="#" alt="Magenta" /></td>
<td><img src="#" alt="Black" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Technical Information:**

- **Software:** Aldus FreeHand 3.1
- **Hardware:**
  - Mac IIx
  - RAM 8 MB
  - SuperMac Trinitron 19"
  - SuperMac Spectrum PDQ
  - 24 bit VideoCard
- **Color Proofing:**
  - OMS Color/Script 100
  - Canon CLC 500
- **Line Screen:**
  - 150 lines per inch
- **Printing:**
  - SpeedMaster
  - 28" x 40" presses with standard process inks
- **Paper:**
  - 128 g matt art
**Technical Information:**

- **Software:** Aldus FreeHand 3.1
- **Hardware:**
  - Mac IIX
  - RAM 8 MB
  - SuperMac
  - Trinitron 19"
  - SuperMac Spectrum PDD
  - 24 bit VideoCard
- **Color Proofing:**
  - OMS ColorScript 100
  - Canon CLC 500
- **Line Screen:** 150 lines per inch
- **Printing:**
  - SpeedMaster
  - 28" x 40" presses
  - with standard process inks
- **Paper:** 128 g matt art
### Process Color Scale

<table>
<thead>
<tr>
<th>Cyan</th>
<th>Magenta</th>
<th>60 black</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Cyan 55]</td>
<td>![Magenta 55]</td>
<td>![60 black 55]</td>
</tr>
<tr>
<td>![Cyan 60]</td>
<td>![Magenta 60]</td>
<td>![60 black 60]</td>
</tr>
<tr>
<td>![Cyan 65]</td>
<td>![Magenta 65]</td>
<td>![60 black 65]</td>
</tr>
<tr>
<td>![Cyan 70]</td>
<td>![Magenta 70]</td>
<td>![60 black 70]</td>
</tr>
<tr>
<td>![Cyan 75]</td>
<td>![Magenta 75]</td>
<td>![60 black 75]</td>
</tr>
<tr>
<td>![Cyan 80]</td>
<td>![Magenta 80]</td>
<td>![60 black 80]</td>
</tr>
<tr>
<td>![Cyan 85]</td>
<td>![Magenta 85]</td>
<td>![60 black 85]</td>
</tr>
<tr>
<td>![Cyan 90]</td>
<td>![Magenta 90]</td>
<td>![60 black 90]</td>
</tr>
<tr>
<td>![Cyan 95]</td>
<td>![Magenta 95]</td>
<td>![60 black 95]</td>
</tr>
<tr>
<td>![Cyan 100]</td>
<td>![Magenta 100]</td>
<td>![60 black 100]</td>
</tr>
</tbody>
</table>

### Technical Information:

**Software:**
- Aldus FreeHand 3.1

**Hardware:**
- Mac IIx
- RAM: 64 MB
- SuperMac
- Trinitron 19"
- SuperMac Spectrum PDQ
- 24 bit VideoCard

**Color Proofing:**
- OMS ColorScript 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster 28" x 40" presses
  - With standard process inks

**Paper:**
- 128 g matt art
<table>
<thead>
<tr>
<th>Process color scale</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>55</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>65</td>
</tr>
<tr>
<td>70</td>
</tr>
<tr>
<td>75</td>
</tr>
<tr>
<td>80</td>
</tr>
<tr>
<td>85</td>
</tr>
<tr>
<td>90</td>
</tr>
<tr>
<td>95</td>
</tr>
<tr>
<td>100</td>
</tr>
</tbody>
</table>

Technical Information:

Software:
Aldus FreeHand 3.1

Hardware:
Mac IIx
RAM 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PDO
24 bit VideoCard

Color Proofing:
OMS ColorScript 100
Canon CLC 500

Line Screen:
150 lines per inch

Printing:
SpeedMaster
28" x 40" presses with standard process inks

Paper:
128 g matt art
Technical Information:

Software: Aldus FreeHand 3.1

Hardware: Mac IIx
RAM 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PDQ
24 bit VideoCard

Color Proofing: QMS ColorScript 100

Line Screen: 150 lines per inch

Printing: SpeedMaster 28" x 40" presses with standard process inks

Paper: 128 g matt art
### Technical Information:

**Software:**
Aldus FreeHand 3.1

**Hardware:**
- Mac IIfx
- RAM 8 MB
- SuperMac Trinitron 19"
- SuperMac Spectrum PDO 24 bit VideoCard

**Color Proofing:**
- QMS ColorScript 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster 28" x 40" presses with standard process inks

**Paper:**
- 128 g matt art
Technical Information:

Software:
Aldus FreeHand 3.1

Hardware:
Mac IIx
RAM 8 MB
SuperMac Trinitron 19"
SuperMac Spectrum PDD
24 bit VideoCard

Color Proofing:
QMS ColorScript
100
Canon CLC 300

Line Screen:
150 lines per inch

Printing:
SpeedMaster 28" x 40" presses with standard process inks

Paper:
128 g matt art
<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan</td>
<td>Yellow</td>
<td>40 Black</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Technical Information:
- Software: Aldus FreeHand 3.1
- Hardware: Mac IIfx, RAM 8 MB, SuperMac Trinitron 19'', SuperMac Spectrum P00, 24 bit VideoCard
- Color Proofing: OMS ColorScript 100, Canon CLC 500
- Line Screen: 150 lines per inch
- Printing: SpeedMaster 28'' x 40'' presses with standard process inks
- Paper: 128 g matt art
<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan</td>
<td>Yellow</td>
<td>50 Black</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Technical Information:

Software: Aldus FreeHand 3.1

Hardware:
- Mac IIx
- RAM 8 MB
- SuperMac Trinitron 19"
- SuperMac Spectrum POQ 24 bit VideoCard

Color Proofing:
- QMS ColorScript 180
- Canon CLC 500

Line Screen:
- 150 lines per inch

Printing:
- SpeedMaster 28" x 40" presses with standard process inks

Paper:
- 128 g matt art
Technical Information:

Software:
Aldus FreeHand 3.1

Hardware:
Mac IIx
RAM 8 MB
SuperMac
Trinitron 19”
SuperMac
Spectrum PDQ
24 bit VideoCard

Color Proofing:
OMS Color/Script 103
Canon CLC 500

Line Screen:
150 lines per inch

Printing:
SpeedMaster
28” x 40” presses
with standard process inks

Paper:
126 g matt art
Process color scale

Technical Information:

Software: Aldus FreeHand 3.1

Hardware:
- Mac IIx
- RAM 8 MB
- Trinitron 19"
- Spectrum PDQ
- 24 bit VideoCard

Color Proofing:
- CMS ColorScript 100
- Canon CLC 500

Line Screen:
- 150 lines per inch

Printing:
- SpeedMaster
- 28 x 40' presses with standard process inks

Paper:
- 128 g matt art
Technical Information:

Software: Aldus FreeHand 3.1
Hardware: Mac IIx
RAM: 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PDO
24 bit VideoCard
Color Proofing: OMS ColorScript 100
Canon CLC 500
Line Screen: 150 lines per inch
Printing: SpeedMaster 28" x 40" presses with standard process inks
Paper: 128 g matt art
<table>
<thead>
<tr>
<th></th>
<th>Magenta</th>
<th>Yellow</th>
<th>Black</th>
</tr>
</thead>
<tbody>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Technical Information:**

- **Software:** Aldus FreeHand 3.1
- **Hardware:**
  - Mac IIx
  - RAM 8 MB
  - SuperMac
  - Trinitron 19"
  - SuperMac Spectrum P99
  - 24 bit VideoCard
- **Color Proofing:**
  - QMS ColorScript 100
  - Canon CLC 500
- **Line Screen:** 150 lines per inch
- **Printing:** SpeedMaster 28" x 40" presses with standard process inks
- **Paper:** 128 g matt art
<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Process color scale

<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magenta</td>
<td>Yellow</td>
<td>50 Black</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Technical Information:

Software: Aldus FreeHand 3.1
Hardware:
- Mac IIx
- RAM 8 MB
- SuperMac
- Trinitron 19"
- SuperMac
- Spectrum PDQ
- 24 bit VideoCard
Color Proofing:
- OMS ColorScript 100
- Canon CLC 500
Line Screen: 150 lines per inch
Printing:
- SpeedMaster 26" x 40" presses with standard process inks
Paper: 128 g matt art
Process color scale

Technical Information:
Software:
Aldus FreeHand 3.1
Hardware:
Mac IIfx
RAM 8 MB
SuperMac
Trinitron 19"
SuperMac
Spectrum PDO
24 bit VideoCard
Color Proofing:
OMS ColorScript 100
Canon CLC 500
Line Screen:
150 lines per inch
Printing:
SpeedMaster
28" x 40" presses
with standard process inks
Paper:
128 g matt art
<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Process Color Scale

<table>
<thead>
<tr>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
<th>95</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Magenta.png" alt="Magenta" /></td>
<td><img src="Yellow.png" alt="Yellow" /></td>
<td><img src="70Black.png" alt="70 Black" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Technical Information:**

**Software:**
- Aldus FreeHand 3.1

**Hardware:**
- Mac IIfx
- RAM 8 MB
- SuperMac Trinitron 19
- SuperMac Spectrum PDQ
- 24 bit VideoCard

**Color Proofing:**
- OMS ColorScript 100
- Canon CLC 500

**Line Screen:**
- 150 lines per inch

**Printing:**
- SpeedMaster 28" x 40" presses with standard process inks

**Paper:**
- 128 g matt art
Graduation is tonal contrast between two points. It is an effective device to give an illusion of space and depth. Traditionally the artist had to use a fine ink spray with air-driven pen (airbrush) to achieve this effect. Today, it is accessible to all MAC users with many software programs. To achieve the above effects, we had to draw a series of shapes to form a whole square. Process color percentages were plotted and filled between two points and the MAC did the graduation (or airbrush).
Technical Notes: FreeHand 3.1 • draw the individual graphic block of the triangle • go to Fill and line in the Attributes menu and specify your color and angle direction by adjusting the hand of the ‘clock’ • click OK (Graduation can only be done within a graphic block, starting from point A to B. These points normally have contrasting hue, tone or brightness. The example above illustrates one-color graduation.)
Two-color graduation – Pastel scheme
Two-color graduation – Pastel scheme
Two-color graduation - Mid-tone scheme
Two-color graduation – Mid-tone scheme
Two-color graduation – Bright scheme
Two-color graduation – Bright scheme
Two-color graduation – Dull scheme
Two-color graduation – Dull scheme
Three-color graduation – Bright scheme
Three-color graduation – Pastel scheme
Three-color graduation – Dark scheme
Three-color graduation – Bright scheme
Colors are influenced by colors around them, generating brillance, luminosity or losing them in the process. Size can also appear to be different. The luminosity of yellow is exaggerated on a black background. But on white or gray background, it projects subtle warmth. Yellow is often used in combination with other colors and is not always suitable as a spot color.
Process color

Color on white, gray and black

10 magenta 55 yellow
15 magenta 70 yellow
30 magenta 80 yellow
35 magenta 70 yellow 15 black
40 magenta 80 yellow 20 black
45 magenta 80 yellow 30 black
40 magenta 100 yellow 45 black
70 magenta 100 yellow 60 black
100 magenta 100 yellow 75 black

Technical Note: FreeHand 3.1 • draw 2 rectangular boxes one within the other • go to Fill and line in Attributes menu and specify colors from the Color pop-up menu • fill the background of the boxes with gray and black respectively • click OK
Reddish-orange suggests dynamic energy. On the whiter shade, it loses its energy and tends to be beigy. When black is added, it turns brownish. The warmth of orange is accentuated against a black background but loses its shine on gray; on a white background, it still maintains its presence. Suitable for text color in the darker shades. True orange is very difficult to reproduce in process color. It is advisable to use spot color if that color choice is critical.
Process color

Color on white, gray and black

10 magenta 20 yellow

15 magenta 25 yellow

25 magenta 45 yellow

35 magenta 60 yellow

50 magenta 75 yellow

60 magenta 85 yellow

70 magenta 100 yellow

75 magenta 100 yellow 5 black

85 magenta 100 yellow 20 black

Background: white

Background: 50% black

Background: 100% black
A hot passionate choice, red is not an easy color to use although it is very popular. It changes its mood easily when placed next to other colors such as yellow or blue. It tends to stand out more. On black, red glows with luminosity. But on white, it appears to darken.
Process Color

Color on white, gray and black

30 magenta
50 magenta
70 magenta
100 magenta
100 magenta 30 yellow 5 black
100 magenta 60 yellow 15 black
100 magenta 80 yellow 45 black
100 magenta 100 yellow 65 black
100 magenta 100 yellow 70 black

Background: white

Background: 50% black

Background: 100% black
Violet - the royal color. With the presence of red in its mixture, it can be both mysterious and terrifying. Violet has more intensity than blue. As magenta and cyan are sensitive colors in the printing process, it is critical to check your color carefully on press to obtain the desired results.
Color on white, gray and black

- 5 cyan 25 magenta
- 10 cyan 40 magenta
- 20 cyan 55 magenta
- 25 cyan 75 magenta
- 35 cyan 80 magenta 20 yellow
- 45 cyan 85 magenta 25 yellow
- 55 cyan 100 magenta 30 yellow
- 60 cyan 100 magenta 45 yellow
- 70 cyan 100 magenta 55 yellow

Background: white
Background: 50% black
Background: 100% black
Blue - a passive, quiet color. It is cold but it can spark off a silent luminosity against black. On white, surrounding blue appears whiter and brighter. It also looks darker when compared with the same blue in the black rectangle. It appears to dull slightly on gray and project a cold luminosity on black.
Color on white, gray and black

20 cyan 5 yellow

40 cyan 5 yellow

50 cyan 10 yellow

65 cyan 15 yellow

100 cyan 15 yellow

90 cyan 5 yellow 10 black

90 cyan 20 magenta 10 black

100 cyan 40 magenta 15 black

100 cyan 55 magenta 30 black

Background: white

Background: 50% black

Background: 100% black
Green is produced by combining a larger percentage of yellow against cyan. This combination can give you a wide range of green.
Process color

Color on white, gray and black

20 cyan 15 yellow

40 cyan 25 yellow

55 cyan 35 yellow

75 cyan 35 yellow

95 cyan 45 yellow

95 cyan 35 yellow 5 black

100 cyan 40 yellow 10 black

100 cyan 45 yellow 15 black

100 cyan 50 yellow 20 black

Background: white

Background: 50% black

Background: 100% black
Notice how the white rectangle inside the black frame looks bigger than those colors on white background. The gray rectangle inside the black frame also looks lighter than the same gray on a white background. This experiment demonstrates how the range of gray behaves against white, gray (50% black) or black background.
Process color

Color on white, gray and black

Background: white

10 black

20 black

30 black

40 black

55 black

60 black

70 black

80 black

85 black

Background: 50% black

Background: 100% black
Complementary color match. Page 256

Process color and line art. Page 266

How to use the color chart

If the color chart code is 29, refer to the chart on the right to find out the percentages of the process color, e.g. code 29 is 70% Magenta and 90% Yellow.

99% Cyan, 50% Magenta

70% Magenta, 90% Yellow

Four-color mix and match. Page 260
Color is like the words of a language. It only makes sense, or nonsense, when used together. We seldom use color in isolation but with many other colors around it. The way we view color can also differ. There are many variables that can affect our judgement of color. The quality of our eyesight, the light source, the color 'environment' around your selected color, and our personal bias. There are ways to minimise poor color judgement and to avoid the pitfalls. The samples in the following pages serve as useful guides.

### Color Combination

#### MATCHING COLORS
- Monochromatic color match
- Blending color match
- Contrast color match
- Complementary color match
- Color and gray match
- Four-color mix and match

#### PROCESS COLOR AND TYPE
- Color type on screen background
- Color type on graduated background

#### GRAPHIC SAMPLES
- Process color and line art

---

<table>
<thead>
<tr>
<th>Code</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
<th>21</th>
<th>22</th>
<th>23</th>
<th>24</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan</td>
<td>91</td>
<td>71</td>
<td>90</td>
<td>50</td>
<td>75</td>
<td>71</td>
<td>80</td>
<td>80</td>
<td>55</td>
<td>81</td>
<td>81</td>
<td>81</td>
<td>100</td>
<td>71</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Magenta</td>
<td>80</td>
<td>80</td>
<td>90</td>
<td>90</td>
<td>60</td>
<td>80</td>
<td>70</td>
<td>40</td>
<td>55</td>
<td>50</td>
<td>60</td>
<td>55</td>
<td>70</td>
<td>80</td>
<td>70</td>
<td>15</td>
<td>25</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>Yellow</td>
<td>30</td>
<td>49</td>
<td>31</td>
<td>100</td>
<td>75</td>
<td>80</td>
<td>79</td>
<td>85</td>
<td>70</td>
<td>30</td>
<td>90</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
<td>79</td>
</tr>
</tbody>
</table>

| Code | 25 | 26 | 27 | 28 | 29 | 30 | 31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 |
|------|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Cyan | 70 | 15 | 80 | 70 | 45 | 100 | 75 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 |
| Magenta | 70 | 15 | 80 | 70 | 45 | 100 | 75 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 |
| Yellow | 49 | 49 | 50 | 90 | 89 | 100 | 99 | 99 | 99 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 | 100 |

| Code | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 | 60 | 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 | 70 | 71 | 72 |
|------|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Magenta | 70 | 100 | 70 | 90 | 70 | 55 | 50 | 80 | 10 | 60 | 80 | 25 | 30 | 90 | 45 | 55 | 80 | 60 | 90 | 20 | 10 | 20 | 20 | 20 |
| Black | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 | 49 |

---

Color and gray match.
Monochromatic color comes from one single hue. We normally term such a color scheme yellowish, grayish, bluish, etc. The difference in such a color scheme comes from its value or tonal quality or intensity – light or dark, or bright or dull.
Technical Note: FreeHand 3.1 • draw a square • draw the jigsaw shapes inside the square using the Combination tool • delete the original square • go to Fill and line in Attributes menu and select Process color • type in the color percentages (Note: the code numbers at the corner of each color represent the tint color percentage. See page 249 for the tint percentage.)
Blending color or 'neighbor' color is the selection of color next to each other in a color wheel. While they can come from two different hues, they are nevertheless a blending color as long as they are close to each other. For example, red, orange and yellow.
Color combination

Blending color match
Contrasting color schemes are lively and energetic. Black and white represent extreme contrast in tone. Yellow, red and blue represent contrast in hue. Contrast can also come from difference in intensity or brightness.
Complementary colors are directly opposite each other in a color wheel. Such a combination emits vibrant radiance to its adjacent color. Yellow and violet, green and red, orange and blue are some examples. Complementary pairs when mixed together give you neutral gray.
Color and gray scheme. This range can provide both a quiet scheme (as at top of this page) and an aggressive scheme (bottom of page 267). Gray, being a neutral color, is compatible with most of the other hues.
Four-color mix and match has no particular direction in its color scheme. This experiment is a menu for your color selection to suit your purpose. Always view your colors with window frame, so that the surrounding colors will not distract your view.
This page shows you how tint text and tint background in process colors behave. The text and background tints are set in a range of 10%, 30%, 50%, 70% and 100% of the process colors. Process colors used independently (as Cyan, Magenta, Yellow or Black) without mixing will have no registration problem during printing, though the independent process colors will have a ‘raw’ look. They work well on a black background.
Technical Note: FreeHand 3.1 • draw the rectangular boxes • go to Fill and line in Attributes menu • select Process color and type in the color percentages • type text in the dialog box using the Text tool • centralize text in the box by using Alignment in the Type menu • go to Color menu and choose the color percentages from Process color.
You can achieve beautiful results by using tint text in process colors over a graduated background of secondary and tertiary colors. A 10% tint text does not show well whereas a solid text (100% tint) gives maximum contrast.
Technical Note: FreeHand 3.1 • draw the rectangular boxes • go to Fill and line in Attributes menu and select Graduated from the Fill pop-up menu • select the colors, taper angle and the angle of graduation • type text in the dialog box using the Text tool and specify the colors of your choice • click OK
Line art in stark black and white provides maximum contrast. By using colors we can create numerous moods. The examples show how colors are used in flat tint, graduated tint, and radial tint. The scanned image is filled with a color and placed against a background filled with another color.
Technical Note: Mac GrayScan 1.6, FreeHand 3.1 • place scanned image in the FreeHand file • duplicate the number of TIFF images and place on a pre-drawn grid • go to Fill and line in Attributes menu and select the colors of your choice • go to Element info in Attributes menu and click on the Transparent button • draw a smaller rectangular box and centralise it within each image • select and fill the colors (see page 266 for graduation effect) • click OK • send your color rectangular boxes to back
Color correction and modification. Page 272

Image enhancement. Page 271

Image modification using filters. Page 270
Image re-touching comes in two basic forms, i.e. to refine or to permute. To refine is to enhance the image quality suitable for reproduction. This area is useful to people in the reprographic arena. To permute is to distort, to shock or to intrigue the viewers, a re-touching technique widely used by creative people. Software like Photoshop, which is extensively used here, is capable of doing just that. You just need time and imagination.
One of the easiest ways to mutate an image is to use the filters in Adobe Photoshop. There are more than two dozen filters within the application that let you apply a myriad of special effects. Your picture can be sharpened, blurred, pointillized, faceted or distorted. You can also use the NTSC Color and De-interlace filters to prepare an image for use in video recording. Be discreet when using filters. Get the appropriate result to suit the project.
Unsharp mask (Amount: 100%, Radius: 3 pixels, Threshold: 10 levels, 2 passes)

Mosaic (8 pixels square)

Find Edges

Tiles (Number of tiles: 5, Max offset: 10%, Fill empty area with inverse Image)

cMulti (Radial, Radius: 30, Width: 45, #Area: 8, Transition: 8, Intensity: 55)

Emboss (Angle: 135°, Height: 6 pixels, Amount: 100)

Technical Note: Images modified with Adobe Photoshop 2.0 • images scanned from 35 mm Ektachrome transparencies with Scitex's Iris Smart Scanner at 300 dpi • layout with PageMaker 4.2 • color separation on Agfa Compugraphic SelectSet 5000 at 2,400 dpi at 150 lpi
Adobe Photoshop is a powerful image manipulation software for color rendering. The color correction can be subtle through the addition or subtraction of CMYK colors or dramatic through re-mapping the whole color curve. It allows you to improve on your scanned images. Photoshop also allows you full control on how you can compensate for deficiency between RGB displays and CMYK reproductions, such as selection of printing processes or ink dot gain.
Image re-touching
Color correction and modification

+50 Yellow
-50 Yellow
Posterising (4 levels)
Using arbitrary map to re-map the color curve
Image converted to Index color and color table edited to a green color range
Posterising (2 levels) the red channel of a RGB image

Technical Note: Images modified with Adobe Photoshop 2.0 • Images scanned from 4" x 5" transparency with Scitex's Iris Smart Scanner at 300 dpi • layout with PageMaker 4.2 • color separation on Agfa Compugraphic SelectSet 5000 at 2,400 dpi at 150 lpi
The original is a 4" x 5" transparency with old and dirty panels, and rather dull sky. The color of the sky was then altered with a transparent color fill (90C, 40M and 5Y) using the fill command of the Edit menu.

The first step involved cleaning up the glass panels using various tools in Photoshop, such as the rubber stamp, pencil tool and the cut and paste method. A 3D logo was added to the image. Its outline was drawn in Aldus FreeHand, saved as a PICT file and opened in Photoshop to be re-sized and placed.

The above exercise illustrates how a designer can use Photoshop to enhance and re-touch transparencies, such as cleaning up the windows, re-touching the scratches, enhancing the color of the sky and adding a 3D logo to achieve the final result as shown on the opposite page. This exercise took approximately 1 1/2 hours to complete.
The final step was to add a glow to the 3D logo. The logo was first placed onto an alpha channel. The entire channel was then inverted. Next, a Gaussian blur filter was applied and the channel was applied onto the color image. The selection was then filled with white to create the glow. The colored 3D logo was finally pasted.

Technical Note: Images modified with Adobe Photoshop 2.0 • images scanned from 4” x 5” transparencies with Scitex’s Iris Smart Scanner at 300 dpi • layout with PageMaker 4.2 • color separation on Agfa Compugraphic SelectSet 5000 at 2,400 dpi at 150 lpi
The 35 mm side of the crowned crane was shot using a 500 mm mirror lens. This shot of a tree trunk showed interesting textures at close-up view. A sunset scene of a rustic village was the final transparency used for this exercise.

The lasso tool, set to #8 feather radius, was used to select the background. The tree trunk scan was copied 'pasted into' the crane image and scaled to size. The crane and the texture were selected and the water was again copied to the clipboard and 'pasted into' the selection and scaled to size.

Compositing multiple images into one used to be an expensive exercise because it required high-end graphics systems such as Scitex, Crosfield or Quantel. Adobe Photoshop allows you to composite images together easily with the tools available. Using simple commands such as select, copy and paste into, you can achieve the same results you see on these pages.
The hard edge between the water and texture was softened using the blur tool. Text was then added to the top of the image. The text was created in Adobe Illustrator 3.0 and saved as an EPS file. The EPS file was then placed on a separate alpha channel and sized to fit the layout. A Gaussian filter with a pixel factor of 4 was applied to the letter selection to create the soft edge. The alpha channel was then applied onto the image and filled with white for the glow. The EPS text file was placed again and overlaid over the glow.

Technical Note: Images modified with Adobe Photoshop 2.0 • images scanned from 35 mm transparencies with Scitex’s Iris Smart Scanner at 300 dpi • layout with PageMaker 4.2 • color separation on Agfa Compugraphic SelectSet 5000 at 2,400 dpi at 150 lpi.
The grayscale image was first opened in Photoshop. The entire image was then copied onto the clipboard for later use.

The sky was then selected with the lasso tool. A 80% Cyan color radial blend was filled in and the noise filter was applied to give the sky a stippled effect.

Using a combination of the paint and airbrush tool, various parts of the statues were painted over with soft pastels colors.

The previously copied image was pasted over the painted version. Using the paste control in the Edit menu, the gray values were merged with the painted one.

The ability of Photoshop to work in various mode (e.g. black and white, grayscale and color) makes it a versatile application to do the kind of work you see above. We started off with a grayscale image and then converted it to CMYK mode for adding color elements into it. Simple techniques such as painting and using the paste control in the Edit menu to control the opacity of pasted images allow you to create visually exciting color images from black and white ones.
A soft pastel orange color was airbrushed onto the statues to give them a little warmth. As we find the bus and people at the lower right hand corner of the image distracting, we had them removed by copying the trees on top and pasting over them.

Technical Note: Images modified with Adobe Photoshop 2.0 • Images scanned from a b/w photograph with Scitex's Iris Smart Scanner at 300 dpi • layout with PageMaker 4.2 • color separation on Agfa Compugraphic SelectSet 5000 at 2,400 dpi at 150 lpi
Drop cap is useful to emphasize a new area in a text.
The appendices are useful information for those in the field of DTP technology. While they are not exhaustive, they enable the lay users to understand DTP terminology and to communicate on the same wavelength with their colleagues, clients and vendors. Using the MAC also requires a certain amount of discipline. The section on Tips and Tricks can save you unnecessary headaches in the course of your work.
8-bit. A system used for displaying colors and grayscales on your Macintosh screen. An 8-bit video system is capable of displaying 256 (2^8) colors or grayscales, at a time, out of 16.8 million colors which the Macintosh is capable of generating. See also *bit*.

24-bit. A system used for displaying colors and grayscales on your Macintosh screen. A 24-bit video system is capable of displaying, at a time, the full 16.8 million colors which the Macintosh is capable of generating. See also *bit*.

**Alignment.** Process of specifying how elements (text and/or graphics) align on a page, towards one another or on a grid. For text alignment, see *ragged left*, *ragged right*, *centered* and *justification*.

**Artwork.** Any black and white or color original prepared for reproduction by manual or mechanical means. Also called *mechanicals*.

**Ascender.** The part of lower case letters such as *b d f h* which rise above the x-height.

**Asterisk.** The sign * which you will get when you press *shift-8* on your keyboard.

**Baseline.** An imaginary horizontal line along which the bottom of capital letters and most lower case letters such as *a c e* align.

**Bit.** An acronym for a binary digit. A binary digit represents either an on or off signal. In computers, all information (whether text, graphics, audio, video) is represented in bits.

**Bitmap.** A file, display or print format in which information in each pixel is represented.

**Bleed.** Images on the artwork which extend beyond the trim marks.

**Blow-up.** To enlarge or an enlargement.

**Body type.** Usually a 14 points (or less) size typeface used for setting text on a page.

**Body.** The vertical area (from ascender to descender) occupied by a character.

**Book.** The medium weight of a typeface intended for text setting.

**Box setting.** Setting text with both sides aligned. Same as justified.

**Braces.** { }. The symbols which you get when you press open and close square brackets on your keyboard while depressing the shift key.

**Brightness.** How dim or bright an object appears to be. See also *HSB*.

**Broadsheet.** A term commonly used to refer to a page the size of a full-size newspaper.

**Bromide.** Light sensitive paper used for printing from the Macintosh by high resolution imagesetters. It is a version of photographic paper.

**Bullet.** The symbol • which you get when you press *option-8* on your keyboard.

**Camera-ready.** Artwork that is ready for the printing process, i.e. for making negative/positive/plate.

**Cap height.** The distance from the baseline to the top of a capital letter.

**Caption.** Text used to describe an image on page.

**Center spread.** The pair of pages which appear at the center of a publication, e.g. pages 4 and 5 of an 8-page publication.

**Centered.** A method of aligning text in which all lines in a paragraph are aligned from the center. See *alignment*.

**Chain.** Refers to a stream of linked text, flowing from one page or column to other pages or columns.

**Character.** Includes upper and lower case letters, numbers and punctuation marks that comprise a font.

**CMYK.** Short for cyan, magenta, yellow and black, the process color in which you can specify the percentage of cyan, magenta, yellow and black to simulate any color of the spectrum.

**Collating.** Gathering pages in the correct order.

**Color separation.** Preparation of color artwork for printing by separating it into individual colors. There are two methods of color separation: process...
color separation and spot color separation. In process color separation, the artwork is separated into four colors: cyan, magenta, yellow and black. In spot color separation, one separation is made for each color used in the artwork.

Condense. To compress one or more characters horizontally.

Continuous tone. Any image such as a photograph that has a complete range of tones from black to white. See also halftone.

Contour. A photograph from which all the background has been removed or etched out.

Copy. In computer terms, to duplicate. In printing terms, the manuscript from which text is to be input.

Crop marks. Crosses drawn or printed on a page to indicate where a printed page should be trimmed.

Cropping. The technique of trimming the edges or part of an illustration to fit a given space.

Cut marks. Same as crop marks.

Default. The settings and features (such as font and size) which you encounter when you open a file on a computer.

Digitizing. The process of converting an image on paper, film, negative, positive, etc into digital form that can be stored in a computer.

Display. Short for Visual Display Unit (VDU), your Macintosh screen or monitor.

Dither. A technique of using two colors to create the appearance of a third. For example, dithering using black and white simulates gray.

Drop caps. The first character of a paragraph which is set in a larger size than the rest of the characters in the paragraph, occupying more than one line of vertical space.

Drop shadow. A shadow effect obtained by duplicating an object and setting the duplicate on one side of the original.

Dummy. A rough sketch, a scaled page layout, or a preliminary drawing representing the final artwork.

Element. A block of text, a graphic, a line, a halftone image, etc.

Em. The amount of horizontal space occupied by the letter M in any font in a normal (not condensed or expanded) style and in a particular size.

En. Half the horizontal space of Em.

EPSF. A file format used by many Macintosh drawing programs. An EPSF file is in two parts: one part consists of PostScript code that describes the image and the other part consists of a graphic screen representation in QuickDraw format which is used for displaying the content of the file on screen.

Expand. To stretch one or more characters horizontally.

Face. See font.

First line indent. Setting the first line in a paragraph away to the right of the remaining lines in the paragraph.

Flush left. See ragged right.

Flush right. See ragged left.

Folio. Same as page number.

Font. A set of characters including alphabets, numbers, accent marks and punctuation marks with a unique appearance in a particular style. For example, the Times typeface consists of four fonts: Times Roman, Times Bold, Times Italic and Times Bold-italic.

Footer. Space in the bottom margin used for setting recurring items such as page number, chapter title, book title, etc. See also header.

Fount. Same as font.

Galley. Text set in continuous columns in a given width prior to page make-up.

Gradation. A screen fill in which a shade of gray or color smoothly tapers to another shade of gray or color.
Graduated. See graduation.

Grain. The direction in which the fibers line up when a sheet of paper is made.

Grayscale. A shade of gray, derived from a percentage of black, assigned to an image or a pixel on a computer screen.

Grid. Consists of non-printable horizontal and vertical lines drawn to help position text and graphics on a page accurately.

Gutter. Refers to space between columns.

H & J. Hyphenation and justification. See hyphenation and justification.

Hairline. Any rule which is about a quarter of a point (0.25) thick.

Halftone. Refers to the negative or positive film which is obtained after the break up of a photograph, using a process camera, into fine dots required for printing.

Hanging indent. Also called outdent. The first line in a paragraph is set away to the left of the remaining lines of the paragraph.

Hard copy. A printed copy of the contents of a computer file.

Header. Space in the top margin used for setting recurring items such as page number, chapter title, book title, etc. See also footer.

Heavy. A particular weight of a typeface, thicker than bold.

HSB. Acronym for hue, saturation and brightness.

Hue. The key characteristic of a color. The hue of bright red or dark red is red.

Hyphenation. The process of breaking words which do not fit in the space available at the end of a line.

Imagesetter. A high resolution output device which receives images from a Macintosh and exposes the image on bromide or film.

Impression. The result of the process of transferring an image from an offset plate to paper.

Indentation. A system of setting text in relation to the margins. There are four types of indents: (a) left indent, (b) right indent, (c) first line indent and (d) hanging indent.

Inside. Refers to the right margin of a left page and the left margin of a right page in a double-sided publication. Same as gutter.

Justification. Alignment of text in a paragraph in such a way that all lines are aligned from the left and right except the last line of a paragraph.

Kerning. Reducing the amount of white space between alphabets.

Landscape. A horizontal page orientation in which text and graphics are set along the width of the page. Also known as wide.

Layout. The arrangement of text and graphics on a page.

Leader. A row of dots, dashes or any other character used to guide the eye between items in columns such as an entry in an index and its corresponding page number.

Leading. Vertical space between lines of text. Leading is usually measured from baseline to baseline.

Left indent. All lines in a paragraph are set away to the right of the left margin.

Letter spacing. Refers to the horizontal space between letters.

Ligatures. A ligature is a single character used to represent two or more characters. Some common ligatures are fi fl.

Light face. A particular weight of a typeface, thinner than medium.

Line art. An image consisting of only black and white elements without continuous tone.

Logo. An emblem or symbol consisting of type and/or illustrations representing a product or an organization.

MAC-graphics®. Graphics produced with the Macintosh hardware and software.

Margins. Space between the edge of the page and the printed area on the four sides of a page.
Mean line. An imaginary horizontal line that marks the tops of lower case letters without ascenders.

Measure. The width of a text block.

Mechanicals. See artwork.

Moiré. An undesirable pattern on printed halftone due to poor angling of screen or registration.

Negative. Any image on paper, screen or film where dark elements appear light and light elements appear dark.

Newsprint. Paper used for printing newspapers.


Origin. The starting co-ordinates of an image measured from the top and left edge of the page or margin.

Outdent. See hanging indent.

Outside. Refers to the left margin of a left page and the right margin of a right page in a double-sided publication.

Overlay. Transparent paper or film placed over artwork for the purpose of showing the breakdown of color in mechanical color separations.

Pantone. A standard for color matching.

PICT. A file format for storing 8-bit black and white images. Newer versions of PICT known as PICT2 and PICT 2 (24-bit) allow storage of 8-bit color and 24-bit color images.

Pixel. Abbreviation for picture element. The individual display dots that make up your Macintosh screen display. The display of the built-in Macintosh screen, for example, consists of 512 pixels horizontally and 342 pixels vertically.

Plate. A thin, flat and rectangular piece of metal (made of aluminium, zinc, etc) onto which the image of an artwork is transferred and mounted on an offset printing machine to make copies.

Point size. The size of characters in a font measured from ascender to descender.

Point. A unit of measurement, approximately 1/72nd of an inch.

Portrait. A vertical page orientation in which text and graphics are set. Also known as tall.

Positive. The opposite of a negative image.

PostScript. A page description language used by Macintosh programs to describe the contents of a page to be printed to a PostScript printer.

Print run. Number of copies to be printed.

Proofreading. The process of reading a proof to detect mistakes in spelling, punctuation, style, font, size, etc and marking corrections on the proof.

Proof. A trial print taken to check for mistakes.

Proofing. The process of obtaining trial copies (or color separation proofs) of color artwork before printing. There are two methods of proofing: off-press and on-press. As their names suggest, on-press proofing is when an offset press is used to print proofs, and off-press proofing is getting proofs using any method other than an offset press to make trial copies, e.g. 3M, Dupont, Kodak, etc.

Proofing Bar. A system to help offset printer in quality control and detecting printing problems.

QuickDraw. A graphics description language used by the Macintosh to display text and graphics on the screen and to print on non-PostScript printers.

Ragged left. A method of aligning text where all lines in a paragraph are aligned from the right but staggered on the left. See alignment.

Ragged right. A method of aligning text where all lines in a paragraph are aligned from the left but staggered on the right. See alignment.

Recto. A right hand page or an odd number page.

Registration marks. Marks, usually consisting of crosses within circles, printed on color separations to facilitate accurate registration during printing.

Registration. The exact positioning of two or more printing impressions.

Resolution. Sharpness of an image measured in pixels per inch in the case of monitors and dots per inch in the case of printers.
RGB. Red, green, blue. A color mixing method used by color monitors to mix percentages of red, green and blue light to create any other color.

Rivers. A term used to refer to too much white space appearing in a block of text.

Rule. A straight line drawn at any angle, thickness or pattern.

Run-around. To make text flow along the path of a line, box or an illustration.

Run-on. To reposition text in a line in such a way that it continues at the end of the previous line.

Sans serif. Without serif. See serif.

Saturation. The attribute of a color in relation to white. The lower the saturation, the whiter the color.

Scale. To reduce or enlarge an image to fit a given size.

Scanned image. Any image that has been captured by a digitizing device such as a scanner, video camera, etc. and stored in a Macintosh.

Screen. A piece of film used for breaking up continuous tone images (such as a photograph) into halftones required for printing. Screens are designated by number of ruled lines they contain, from 50 (coarse) to 300 (very fine) lines per inch. See also tint.

Serif. Short strokes which project from the main strokes of a character.

Set. To type characters and apply attributes such as font, style, size, etc.

Skew. To slant an element horizontally, vertically or both.

Slab serif. A type of font in which characters have rectangular serifs.

Small caps. Capital letters whose height is the same as the x-height in a given font and size.

Solid setting. Setting lines of text without leading.

Spacing. Adjusting spaces between letters, words and lines.


Spread. A pair of facing pages.

Stet. Proofreading term which means to disregard correction mark.

Story. A chain of linked text that occupies one or more columns or pages.

Stripping-in. Manually pasting text or graphics on a page.

Style sheet. A collection of attributes for text, line, color or fill saved for a particular file.

Tabloid. A page (11" x 17") that is about double the size of A4 and half the size of a broadsheet (newspaper size).

Taper. The progression from one color to another in a graduated fill.

Template. A file with preset options for various attributes of text and graphics.

Thumbnails. Miniature representation of pages used for checking design and layout of an entire publication.

TIFF. Short for tagged image file format. A bitmapted file format for storing scanned black and white, line art, grayscale and color images.

Tiling. The process of breaking an image, which is larger than the paper on which it is to be printed, into smaller parts (tiles) the size of the paper, and then assembling the tiles.

Tint. A percentage of a color (usually process color) or a shade of gray.

Tone. The strength of a color or shade of gray, from solid to light.

Typography. The art of selecting and using fonts.

Verso. Left hand page or an even number page.

Weight. The thickness of the strokes of a character categorized into several weights starting from the thinnest (lightest) to the thickest (heaviest).

X-height. The height of lower case letters without ascenders or descenders such as a c e x.
Tips and Tricks In this section, we show you some of the techniques popularly used in graphic design.

Circular Blends
- FreeHand 3.1
  - Draw the circular shape.
  - Draw a line from the centre point of the circular shape downwards. Clone the line and rotate anti-clockwise 90°. Duplicate three times the cloned line.
  - Move the third duplicated line clockwise, as shown in the first diagram.
  - Give the same thickness for all the lines but different colors or tints for each line.
  - Blend from one line to another (25 steps). Do the same to the other lines.
  - Cut the blends and Paste inside the circular shape from the Edit menu.

Creating Transparencies
- FreeHand 3.1
  - Draw a rectangular box and fill it with a color of your choice.
  - Draw a circle on top of the box, choose a color and click None for the keyline.
  - Ungroup it.
  - Clone and move it up to the right and fill it with white.
  - Select a point from each circle and blend it (25 steps). Send the blended object to the back of the rectangular box.
  - Clone the blended object.
  - Hold down the Option key to select the white circle within the blended front object and change its fill to the same color as that of the rectangular box.
  - Cut the blended front object.
  - Activate the box and paste the blended front object using Paste inside command from Edit menu.

Chiseled type
- FreeHand 3.1
  - Outline the shape of "STOP" with a corner tool and fill it with a solid color.
  - Draw the shadowed areas of the chiseled letters. Make sure all the paths are closed. Select a darker tint for the color.
  - Draw a thin highlight stroke tracing the edge of the shadow of each letter.
  - Place both highlight stroke and shadowed area onto each respective letter. Bring both to the front.
Ellipses
- FreeHand 3.1
- Draw a circle and two ellipses using Ellipse tool, positioning them as shown in the first diagram on the left.
- Ungroup all outlines.
- Using the Knife tool and cut the intersecting points of all three elements.
- Delete the unwanted blue lines.
- Select the intersecting mid points of the two red lines and join them.
- Clone the red line.
- Join the cloned red line to the left half circle. Ensure that the path is a closed one and send this section to the back.
- Join the next red line to the other half of the circle. Also ensure that the path is closed.
- Fill both sides with color desired.

Globe
- FreeHand 3.1
- Draw a circle in 1-point line with no fill.
- Clone circle.
- Pressing Option + Scale tool and set Horizontal 5% from centre, uncheck lines under scale options and click OK.
- Select both circles and ungroup them.
- Activate one corresponding point from the centre of each circle.
- Blend (6 steps).
- Clone the element in the second diagram.
- Press Option + Rotation tool and set it to 90° at centre.
- Your completed globe should be similar to the third diagram.

PageMaker’s Duplication
- PageMaker 4.2
- Create a shape.
- Go to Edit menu and copy shape or Command + C
- Press Command + Option + V to paste and move the copied shape to position as shown in the second diagram.
- Press Command + Option + V to duplicate as many shapes as desired.
In-line type
- FreeHand 3.1
- Type text in Lubalin Graph bold, 24 points.
- Set effects to inline ... Background — width (3 points), color (white); Stroke — width (1 point); color (black), mitre limit (30°); iterations — 1.
- Set effects again in Type menu to Inline ... Background — width (3 points), color (white); Stroke — width (1 point), color (black), mitre limit (30°); iterations — 1.
- Set effects to Inline one more time ... Background — width (3 points), color (white); Stroke — width (1 point), color (blue), mitre limit (30°); iterations — 1.

Neon type
- FreeHand 3.1
- Type 'N' in Helvetica bold, 80 points.
- Convert to paths, go to Element menu and select Split elements.
- Clone the 'N' and set line in 12-point black.
- Send to back.
- TAB and select next 'N'.
- Set 1-point line in white and fill with black.
- Drag to select a pair of corresponding points as shown in the second diagram.
- Blend (10 steps).
- Fill background with black.

Emboss type
- FreeHand 3.1
- Type 'E' in Times bold, 90 points in 10% green.
- Clone the 'E'.
- Move position using Command + M and set Horizontal —0.03", Vertical 0.03", color 40% green.
- Duplicate using Command + D to the next position, selecting 100% green for its color and sent 'E' to back or Command + B.
- Fill background with 40% green, also sending it to back.

FreeHand's Eraser
- FreeHand 3.1
- Trace the outline of a shell using the Freehand tool.
- Draw it off position.
- While still holding down the mouse button for the Freehand tool, press the Command key to erase the off-positioned line by retracing over it.
- Release the Command key and continue drawing without letting go of the mouse button.
Encircle Line Art
- FreeHand 3.1
- Draw an ellipse over the surf sail.
- Clone or Command + = and move position of ellipse slightly down.
- Duplicate or Command + D for the two ellipses.
- Use the Pointer tool and select all the rings, aligning them with Command + .
- Ungroup the rings and cut the left and right side handles with the Knife tool. The two ellipses are now separated in two respective halves.
- Without dragging to separate the two respective halves, select the top halves and send to back.

Compound Lines
- FreeHand 3.1
- Draw a closed path in 12-point black with no fill.
- Clone from Edit menu or Command + =.
- Go to Fill and line in Attributes menu.
- Change line to color desired.
- Select defaulted dotted lines under Dash while holding down Option key.
- Set segment lengths On (2 mm) and Off (5 mm) in Line pattern.

Composite Paths
- FreeHand 3.1
- Draw two rectangles to create a frame and align them as shown in the first diagram.
- Command + U to ungroup and Command + J to join both rectangles. You may use commands from Elements menu for both steps.
- Command + E or activate Fill and line from Attributes menu and fill frame with a custom texture and color desired.
- Place from File menu a scanned image and send to back using Elements menu.
In this section, we showcase some of the MAC-graphics contributors. This illustration was done by first studying the Moorish architecture. The image was scanned and traced using FreeHand 3.1. This was further duplicated and re-sized to form an interesting composition. Other elements like the sky and the long shadows were added to provide the dramatic effect.
This illustration was used for press advertising to promote color prepress on the MAC. Drawn using FreeHand 3.1. Extensive blends were used for the background. Fishes rendered with graduated tones. 19 layers and 67 colors used.
After scanning the picture, the artist experimented with the multiple effects of Photoshop. The effects as you can see are both stunning and unexpected. On page 294, the professional comic illustrator used the 'air-brush' effect in Photoshop successfully.
An invitation  You are invited to submit samples of your work to be showcased in MAC-graphics. If they are selected, we will publish them with full credit line in MAC-graphics and present you with a complimentary copy. We prefer that you send your work in diskette form. Please include your name, address, occupation and details of your Macintosh configuration and software used. Please include a brief description on how your work was created. The address to send to is: The Curator, Octogram Publishing Private Limited, Singapore, Blk 79A Indus Road #02-406, Singapore 0316, Republic of Singapore or contact us directly on Tel: 065-2787373 Fax: 065-2783737. Please include a self-addressed envelope if you want your diskette returned to you (postage will be paid by the publisher).


John R. Biggs, *Basic Typography*, 1973. 176pp., Faber and Faber Ltd, 3 Queen Square, London WC 1. This is a comprehensive book on basic typography. Well illustrated and easily understandable.


SOME USEFUL MAGAZINES AND BOOKS

MacUser
950 Tower Lane, 18th Floor
Foster City, CA 94404, USA
Tel: 415-578-9770

MacWorld
501 Second Street, #500
San Francisco, CA 94107, USA
Tel: 415-243-0505

Publish!
501 Second Street
San Francisco, CA 94107, USA
Tel: 415-243-0600

Personal Publishing
191 South Gary Avenue
Carol Stream, IL 60188, USA
Tel: 312-665-1000

The Seybold Report
6922 Wildlife Road
Malibu, CA 90265, USA
Tel: 213-457-5850

Desktop Publishing
363 Ridge Road
PO Box 620025
Woodside, CA 94062, USA

Electronic Publishing and Printing
29 North Wacker Drive
Chicago, IL 60606, USA
Tel: 312-726-2802

ITC Desktop
2 Hammarskjold Plaza
New York, NY 10017, USA
Tel: 212-371-0699

Australian MacWorld
IDG Communications
37-43 Alexander Street
Crow’s Nest 2065, Australia

Macintosh
Neue Winterthurerstrasse 20
3005 Dietikon, Switzerland

MacWorld
Sodra Hamnvagen 22
S-115 41 Stockholm, Sweden

Designers on Mac
Diana Burns
Publisher: Graphic-sha

Electronic Page Design
Michael Gosney and Linea Dayton
Publisher: Prentice Hall

The Official Adobe Photoshop Handbook
David Biedny and Bert Monnoy
Publisher: Bantam Computer Books

Typography Now The Next Wave
Rick Poynor and Edward Booth-Clibborn
Publisher: Internos Books

Real World FreeHand 3
Olar Martin Kvern
Publisher: Bantam Computer Books

Using Aldus FreeHand 3.0
Sharyn Venit and Bruce Fraser
Publisher: Bantam Computer Books

Adobe Illustrator 3.0
(3rd Edition)
Tony Bove, Fred Davis and Cheryl Rhodes
Publisher: Bantam Computer Books

Danny Goodman’s Macintosh Handbook
Danny Goodman, Richard Saul Wurman
Publisher: Bantam Computer Books

The QuarkXPress Book
(2nd Edition)
David Blatner, Steven Roth and Keith Stimely
Publisher: Peachpit Press

QuarkXPress Tips and Tricks
David Blatner and Eric Taub
Publisher: Peachpit Press

Real World PageMaker 4
Olar Martin Kvern and Stephen Roth
Publisher: Bantam Computer Books

For the address of a user group nearest to you, contact:

User Group Connection
Apple Computer, Inc.
M/S 36AA
20525 Mariani Avenue
Cupertino, CA 95014, USA
Tel: 800-538-9696

BCS•Mac Office
Boston Computer Society
48 Grove Street
Somerville, MA 02144, USA
Tel: 617-625-7080

Berkeley Macintosh Users Group (BMUG)
1442A Walnut Street
Berkeley CA 94709, USA
Tel: 415-549-2684
About the Authors

Lim Ching San has worked as a teacher, book designer and print production manager since 1965. He was trained as a graphic designer in Australia and also received training in Japan and Switzerland. He lectures regularly at various institutes in Singapore, and more recently for UNESCO in Beijing, China.

Gim Lee, a fine art artist turned graphic designer since 1980, was trained in the United Kingdom in communication design and has worked as designer/art director in graphic design houses, a publishing group and an international public relations agency.

About the Book

Since 1987 the authors have been deeply fascinated by desktop publishing. They have learned, explored, trained and inevitably invested heavily in this technology. MAC-graphics® is the culmination of the skills and technological know-how mastered over the last few years in Octogram Design.
MAC-graphic® — A designer’s visual guide to graphics for the Apple Macintosh by Lim & Gim

SECOND EDITION, with disk

MAC-graphic® is a comprehensive graphic reference manual addressing the designers, printers, typesetters, serious DTP hobbyists, typographers, color separators and students — those who use type, color and grayscale regularly, and those who do not want to waste their time to obtain the right printed results: the results as proven in print, not on the monitor screen. The book bridges the gap between the design and the production process in desktop publishing.

MAC-graphic® illustrates clearly the possibilities of producing quality printed matter with the Macintosh. This manual puts together the key elements in pre-press production (type, tint, color, grayscale, image, rule, halftone, process color and graduated color) on the MAC. It shows you how they relate to each other in the process of graphic design — the art of visual communication.

This new, updated, upgraded, and enlarged edition includes a disk containing The Color Wheel, a FreeHand document that provides a fast and easy way to calibrate your monitor and help you visualize colors more accurately on screen, and 12 CMYK color charts to help you quickly select and use the right color scheme.

MAC-graphic® is a useful guide not only to new DTPers but is also a useful companion to the graphic designer as well as the advanced MAC users in helping them to produce the printed results they want.

Reviews of MAC-graphic®, first edition

“The ultimate ‘desktop’ book for the graphic designer ... First buy your Mac, then get this book!” Tools of the Trade, USA.

“Covers everything from typeface choices to color processing and line art ... a superior Mac graphics aid.” The Bookwatch, USA.

“Presents an immense amount of information in a relatively compact form.” Computer Publishing Magazine, USA.